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Use the Molecule Profiler software to search for and report on molecules and their derivatives,
including potential impurities and metabolites, in data acquired using the Analyst TF software and
SCIEX OS.

The Molecule Profiler software supports the identification of small molecules, peptides,
Antibody-drug conjugates and oligonucleotides under 10 kDa.
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HowPotential Molecules and Their Derivatives Are
Found
The software has a series of peak finding strategies, or algorithms, that it uses to find potential
molecules in a sample of interest. Refer to the section: About Peak Finding Strategies.

If a found peak is a predicted molecule, then the software assigns a specific name derived from
the precursor or a combination of one or more transformations. Based on the workflow, the
transformations could include a selected biotransformation set, potential cleavage metabolites or
potential hydrolytic cleavages, or potential sequence fragments from an antibody.

For small molecule data analysis, the transformations include a selected biotransformation set
and potential cleavage metabolites.

For peptide data analysis, the transformations include a selected biotransformation set and potential
hydrolytic cleavages.

For antibody drug conjugate (ADC) data analysis, the transformations include a selected
biotransformation set, potential cleavage metabolites, and potential sequence fragments from a
digested antibody protein.

For oligonucleotide analysis, the transformations include a selection of biotransformation sets
suitable for both metabolites and impurities, as well as potential cleavage metabolites and internal
n–1 and terminus n+1 sequences.

If the Generic peak finding strategy is used, and if the peak is an unexpected molecule, then it is
assigned a generic Loss of or Gain of name and the protonated adduct at the charge of the
molecular ion.

If control files are selected with the sample, then the software performs a comparison between
the sample and the control data. If analog files are also selected with the sample, then the software
performs a comparison between the MS and analog data.

Users can change the parameters that control each algorithm. Refer to the section: Select Parameter
Values.

Open the Molecule Profiler Workspace
The SCIEX OS software version 2.1.5 or later must be installed, and a valid Molecule Profiler
software license must be activated.

1. Select the software from the Start menu: Start > SCIEX OS > SCIEX OS.
If the software is configured for Integrated mode, then the home page opens.

If the software is configured for Mixed mode, then the Logon dialog opens. Continue with
the following step.
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2. If the Logon dialog opens, then type the user name and password of a user who is authorized
to use the software, and then click OK.
The Home page opens.

3. Click the Molecule Profiler tile.

Figure 1-1 Molecule Profiler Tile

The Molecular Profiler workspace opens.

Molecule Profiler Window

Figure 1-2 Molecule Profiler Window
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DescriptionItem

List of workspaces1

Batch workspace. Use this workspace to search for potential metabolites.
Refer to the section: About the Batch Workspace.

2

Results workspace. Use this workspace to view potential metabolites after
processing. Refer to the section: About the Results Workspace.

3

Correlation workspace. Use this workspace to compare metabolites found in
different Results files. Refer to the section: About the Correlation Workspace.

4

List of workflows5

Compound library. Create and maintain a library of compounds. Refer to the
section: Compound Library.

6

Biotransformations. Create and maintain lists of common transformations.
Refer to the section: Biotransformation Sets.

7

Processing parameters. Create and maintain processing methods that can
be used in the batch workspace. Refer to the section: Create Processing
Methods.

8

Menu bar. Refer to the table: Table 1-1.9

Table 1-1 Menu Commands

DescriptionItem

File Menu

• Batch: Creates a new batch. Refer to the section: Create a Batch.

• Correlation: Creates a new correlation. Refer to the section: Prepare for
Correlation.

New

• Batch: Opens a batch.
• Correlation: Opens a correlation file.
• Results: Opens a results file.

Open

Saves the batch in the Batch workspace.Save Batch

Saves the batch in the Batch workspace with a different name.Save Batch As

Creates a report. Refer to the section: Reports.Create Report

Opens a recent report.Recent reports
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Table 1-1 Menu Commands (continued)

DescriptionItem

Edit Menu

Edits the name and formula for a compound.Edit Name

Copies the selected table.Copy Selected
Table

Copies the selected graph.Copy Selected
Graph

Copy the selected batch row.Copy Batch Row

Paste the copied batch row in the selected location.Paste Batch Row

Delete the contents of the selected batch row.Clear Batch Row

Delete the selected row from the Results table. The software recalculates the
results.

Delete Selected
Row

Restores the last deleted row. The software recalculates the results.Undo Delete

Hides rows that are not selected.Hide Unchecked
Rows

Shows rows that are not selected.Show Hidden
Rows

Opens the Custom Elements dialog. Use this dialog to define amino acids
and oligonucleotide residues. Refer to the section: Custom Elements.

Custom
Elements

Setup Menu

Opens the compound library. Refer to the section: Compound Library.Compound
Library

Opes the list of biotransformation sets. Refer to the section: Biotransformation
Sets.

Biotransformations

Opens the processing methods window. Refer to the section: Create
Processing Methods.

Processing
Parameters
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Table 1-1 Menu Commands (continued)

DescriptionItem

• Results: Set filters for the Results workspace. Refer to the section: About
Results Filters.

• Correlation: Set filters for the Correlation workspace. Refer to the section:
About Correlation Filters.

• Interpretation: Set filters for the interpretation workspace.

Filters

Creates a folder. Refer to the section: Create Folders.Create New
Folder

Create Folders
Folders store the files required by the software to find potential molecules in a sample of interest,
as well as the Results files.

Custom folders can also be created to organize results.

1. Click Setup > Create New Folder.
The Create New Folder dialog opens.

2. Type a Name for the folder.
The Location field shows the installed location of the Data directory
(C:\ProgramData\SCIEX\Molecule Profiler\Data). All folders that are created are stored in
this directory.

3. Click OK.
When a folder is created, two sub-folders are automatically created, the Processing
Parameters folder and Results folder.
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The Custom Elements dialog contains these tabs:

• The AA List tab contains information for a list of standard amino acids. This information cannot
be edited or deleted. Users can add custom amino acids to this list, and then modify or delete
the added items, as required. The added amino acids are automatically added to the bottom
of the list. However, the list can be sorted by clicking any one of the column headers.

• The AA Modifications tab contains the mass shift information for the various modifications that
can be applied to peptide terminal groups and side-groups of amino acid residues. This
information cannot be edited or deleted. Users can add custom amino acid modifications to the
list, and then modify or delete the added items, as required. The added amino acid modifications
are automatically added to the bottom of the list. However, the list can be sorted by clicking
any one of the column headings.

• The Oligo List tab contains the predefined oligonucleotide residues and terminal groups. This
information cannot be edited or deleted. Users can add new oligonucleotide residues and
terminal groups to this list, and then modify or delete the added items, as required. The added
residues are automatically added to the bottom of the list. However, the list can be sorted by
clicking any one of the column headers.

Custom Amino Acids
Create a Custom Amino Acid

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the AA List tab is selected.

3. Click New.
The New Custom Amino Acid Residue dialog opens.

4. Complete the fields described in the following table and then click OK.
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Table 2-1 New Custom Amino Acid Residue Dialog Fields

Acceptable ValueDescriptionField

AlphanumericName for the amino acidName

• Alphanumeric

• First letter should be uppercase

Symbol for the amino acidSymbol

Empirical formula, using periodic
elements. An enriched isotope can
also be used as part of the formula.
For example, 13C, where 13C
indicates 13-carbon isotope.

Formula for the amino acidResidue
Formula

The custom amino acid is added to the bottom of the amino acid table and shows the name,
symbol, and mass.

Edit a Custom Amino Acid

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the AA List tab is selected.

3. Select the amino acid to be edited.

Note: Only the custom amino acids that have been added by the user can be edited.
Amino acids distributed with the software cannot be edited.

4. Click Edit.
The Edit Custom Amino Acid Residue dialog opens.

5. Edit the fields described in the following table.
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Table 2-2 Edit Custom Amino Acid Residue Dialog Fields

Acceptable ValueDescriptionField

AlphanumericName for the amino acidName

• Alphanumeric

• First letter should be uppercase

Symbol for the amino acidSymbol

Empirical formula, using periodic
elements

Formula for the amino acidResidue
Formula

6. Click OK.
The name, symbol, and mass of the selected custom amino acid are updated, if applicable,
in the amino acid table.

Delete a Custom Amino Acid

Note: Deleting a custom amino acid that is used in a processing method or result can result in
unexpected behavior.

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the AA List tab is selected.

3. Select the amino acid to be deleted.

Note: Only the custom amino acids that have been added by the user can be deleted.
Amino acids distributed with the software cannot be deleted.

4. Click Delete.
The custom amino acid is removed from the amino acid table.

Custom Amino Acid Modifications
Create a Custom Amino Acid Modification

Note: Custom amino acid modifications can only be applied to standard amino acids.
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1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the AA Modifications tab is selected.

3. Click New.
The New Custom Modification dialog opens.

4. Complete the fields described in the following table and then click OK.

Table 2-3 New Custom Modification Dialog Fields

Acceptable ValueDescriptionField

AlphanumericName for the residueName

• Must begin with _

• Alphanumeric

• First letter should be uppercase

Symbol for the residueSymbol

Empirical formula, using periodic
elements

Formula gained by the residueFormula Gain

Empirical formula, using periodic
elements

Formula lost by the residueFormula Lost

Amino Acid, N-Terminus,
C-Terminus, Protein N-Terminus,
and Protein C-Terminus

Position of the modificationMod Type

A single-letter representation of the
standard amino acid to which the
custommodification will be applied,
for example P for proline. Leave this
field empty to apply the custom
modification to all standard amino
acids.

Name of the related amino acidApplies to AA

The custom amino acid modification is added to the bottom of the amino acid modifications
table and shows the symbol, mass shift, and name.

Edit a Custom Amino Acid Modification

1. Click Edit > Custom Elements.
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The Custom Elements dialog opens.

2. Make sure that the AA Modifications tab is selected.

3. Select the modification to be edited.

Note:Only the modifications that have been added by the user can be edited. Modifications
distributed with the software cannot be edited.

4. Click Edit.
The Edit Custom Modification dialog opens.

5. Edit the appropriate fields described in the following table.

Table 2-4 Edit Custom Modification Dialog Fields

Acceptable ValueDescriptionField

AlphanumericName for the residueName

• Must begin with _

• Alphanumeric

• First letter should be uppercase

Symbol for the residueSymbol

Empirical formula, using periodic
elements

Formula gained by the residueFormula Gain

Empirical formula, using periodic
elements

Formula lost by the residueFormula Lost

Amino Acid, N-Terminus,
C-Terminus, Protein N-Terminus,
and Protein C-Terminus

Position of the modificationMod Type

A single-letter representation of the
standard amino acid to which the
custommodification will be applied,
for example P for proline. Leave this
field empty to apply the custom
modification to all standard amino
acids.

Name of the related amino acidApplies to AA

6. Click OK.
The name, symbol, and mass shift of the selected custom modification are updated, if
applicable, in the modifications table.
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Delete a Custom Amino Acid Modification

Note: Deleting a custom amino acid modification that is used in a processing method or result
can result in unexpected behavior.

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the AA Modifications tab is selected.

3. Select the modification to be deleted.

Note: Only the custom modifications that have been added by the user can be deleted.
Modifications distributed with the software cannot be deleted.

4. Click Delete.
The custom modification is removed from the modifications table.

Custom Oligonucleotide Residues or Terminal
Groups
Use custom elements to create sequences that contain custom functional groups that can be
added to the core structure of an oligonucleotide. Thesemodifications can be entered in a sequence
and then searched and identified by the Molecule Profiler software.

An oligonucleotide can be broken down into several substructures.
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Figure 2-1 Oligonucleotide Substructures

Users can change the core substructures of an oligonucleotide or define a new core, terminus,
and phosphate backbone. When creating a custom modified sequence, use this generalized
structure:

5'-(Terminus Moiety)-(Terminus Linker)-(Terminus Phosphate Core)-(Residue Type)1-…-(Residue
Type)n-(Terminus Phosphate Core)-(Terminus Linker)-(Terminus Moiety)-3'

In the New Oligo Residue or Terminus dialog, the Type field contains several predefined types of
residues or terminus. These predefined types restrict editing to certain substructures of the
oligonucleotide, to simplify the creation of modifications that are specific to the type itself. To
understand how each type fits into the general structure outlined above, refer to the following table.

Table 2-5 Types

Editable SubstructureCategoryType

BaseResidue TypeDNA

BaseResidue TypeDNA*

BaseResidue TypeRNA

BaseResidue TypeRNA*

BaseResidue Type2'-O-Methyl RNA

BaseResidue Type2'-O-Methyl RNA*

BaseResidue TypeLocked (LNA)

BaseResidue TypeLocked (LNA)*
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Table 2-5 Types (continued)

Editable SubstructureCategoryType

Base

5' Linker

Sugar Core

3' Linker

Phosphate Core

Residue TypeOther Residue

Terminus MoietyTerminus MoietyPhospho Terminus*

Terminus MoietyTerminus MoietyPhospho Terminus

Terminus Moiety

Terminus Linker

Phosphate Core

Terminus Moiety

Terminus Linker

Terminus Phosphate Core

Other Terminus

* Phosphorothioated backbone

The most flexible type for adding and editing chemical formulas is "Other Residue". It can be
changed to accommodate multiple different custom substructures, allowing the user to define
highly customized oligonucleotides. Similarly the Other Terminus type allows the user to define a
custom 5' or 3'-terminus, linker, and core.

For an example, Refer to the section: Example Custom Oligonucleotide.

Create a Custom Oligonucleotide Residue or Terminal Group

Tip! To create an oligonucleotide residue or terminal group by copying an existing one, select
the existing item on the Oligo List tab, and then click New From.

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the Oligo List tab is selected.

The list contains all of the predefined oligonucleotide residues and terminal groups.

3. Click New.
The New Oligo Residue or Terminus dialog opens.

4. Complete the fields on the dialog. For examples, refer to the section: Example Custom
Oligonucleotide.
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5. Click OK.
The custom residue or terminal group is added to the bottom of the table.

Edit a Custom Oligonucleotide Residue or Terminal Group

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the Oligo List tab is selected.

3. Select the residue or terminal group to be edited.

Note: Only the residues and terminal groups that have been added by the user can be
edited. Residues and terminal groups distributed with the software cannot be edited.

4. Click Edit.
The Edit Custom Amino Acid Residue dialog opens.

5. Edit the properties of the residue or terminal group.

6. Click OK.

Delete a Custom Oligonucleotide Residue or Terminal Group

Note: Deleting a custom oligonucleotide residue or terminal group that is used in a processing
method or result can result in unexpected behavior.

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the Oligo List tab is selected.

3. Select the residue or terminal group to be deleted.

Note: Only the residues and terminal groups that have been added by the user can be
deleted. Residues and terminal groups distributed with the software cannot be deleted.

4. Click Delete.
The custom residue or terminal group is removed from the table.

Import Oligonucleotide Residues and Terminal Groups
Oligonucleotide residues and terminal groups can be imported from a text file.
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1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the Oligo List tab is selected.

The list contains all of the predefined oligonucleotide residues and terminal groups.

3. Click Import.
The Import Text File dialog opens.

4. Browse to the text file, select it, and then click Open.

Export Oligonucleotide Residues and Terminal Groups
Oligonucleotide residues and terminal groups can be exported to a text file.

1. Click Edit > Custom Elements.
The Custom Elements dialog opens.

2. Make sure that the Oligo List tab is selected.

The list contains all of the predefined oligonucleotide residues and terminal groups.

3. Select the oligonucleotide residues and terminal groups to be exported.

Tip! Press Ctrl+A to select all of the residues and terminal groups in the list.

4. Click Export.
The Save As dialog opens.

5. Type the name of the text file in which the exported oligonucleotide residues and terminal
groups will be saved.
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The Compound Library stores information including chemical formula, structure or sequence,
isotope pattern, and MS/MS spectra for compounds. Users can also specify the reference spectrum
for each compound. Each entry in the library can be used to create processing parameters.

The software is installed with a basic library of compounds but users can customize the library by
adding, editing, and deleting entries.

Note: Each entry requires a chemical formula and at least one MS/MS spectrum.

Compound Library Options

Add an Oligonucleotide
Sequence

Add a Peptide SequenceAdd a Structure

How Structures and Sequences are Used
Chemical structures and peptide and oligonucleotide sequences are used by the software to
generate compound-specific parameter values, such as potential cleavage metabolites.

Note: The software automatically generates a chemical formula from the structure or sequence.

The software accepts both v2000 and v3000 mol files, including those with Markush or multiple
structures.

Add a Structure
Use wiff files and txt files to add a reference spectrum to individual entries in the Compound Library.

1. In the Workflow panel, click Compound Library.
The Compound Library dialog opens.
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2. Do one of the following:

• Create a new compound.
a. Click New and then select Structure from the option list.

The New Entry dialog opens.

b. Type a Name for the compound and then click OK.
The software automatically populates the Compound name field on the Compound
Library dialog with the name provided

• Select a compound from the list provided in the Compound name field.
The Compound Library dialog is updated with the information corresponding to the
selected compound.

3. Click Open Structure.
The Open Structure File dialog opens.

4. Browse to and then select a valid mol file.

5. Click Open.
The software populates the following fields in the Compound Library dialog:

• Structure

• Chemical formula

• Polarity

• Isotope Pattern

By default, the Adduct field is populated with a singly-charged protonated adduct [M+H]+
or [M-H]–. The software also updates the m/z field with the appropriate information.

6. Select the Polarity of the acquisition.
The Isotope Pattern and the m/z and Adduct values on the Compound Details tab are
updated, based on the polarity selected.

7. Complete the following fields with the appropriate information:

• Compound class

• CAS number

• Comments (For example, information about metabolite classes can be added to this
field.)

8. Open the Experimental Data tab.
9. Do one of the following:

• To add a reference MS/MS spectrum from a wiff file, continue with the section: Add a
Reference MS/MS Spectrum from a wiff File.
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• To add a reference MS/MS spectrum from a txt file, continue with the section: Add a
Reference MS/MS Spectrum from a txt File.

Add a Peptide Sequence
Use wiff files and txt files to add a reference spectrum to individual entries in the Compound Library.

1. In the Workflow panel, click Compound Library.
The Compound Library dialog opens.

2. Click New and then select Sequence from the option list.

The New Entry dialog opens.

3. Type a Name for the compound and then click OK.
The software automatically populates theCompound name field on the Compound Library
dialog with the name provided.

4. Type the appropriate peptide sequence in the Sequence field.

Note: The sequence can contain custom elements. Refer to the section: Custom Elements.

5. Click in the Chemical formula field.
The software populates the following fields on the Compound Library dialog:

• Chemical formula

• Polarity

• Isotope Pattern

By default, theAdduct field is populated with a doubly-charged protonated adduct [M+2H]2+
or [M-2H]2–. The software also updates the m/z field with the appropriate information.

6. Select the Polarity of the acquisition.
The Isotope Pattern and the m/z and Adduct values on the Compound Details tab are
updated, based on the polarity selected.

7. Click the Experimental Data tab.

8. Do one of the following:

• To add a reference MS/MS spectrum from a wiff file, continue with the section: Add a
Reference MS/MS Spectrum from a wiff File.
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• To add a reference MS/MS spectrum from a txt file, continue with the section: Add a
Reference MS/MS Spectrum from a txt File.

Peptide Sequence Naming Conventions
Table 3-1 Peptide Sequences

ExampleInput ConventionCharacteristic

LIGHTCHAIN /

HEAVYCHAIN

/Multiple Chains

M[Oxi][Symbol]Modification on amino acid:
Side group

Y-[Ami]-[Symbol]Modification on amino acid:
C-Terminal

[1Me]-Y[Symbol]-Modification on amino acid:
N-Terminal

S-S Bridge:

MYC[*1]PEPC[*1]TIDE

• [*#] on each bonded residue

• The number on each linked
residue

Linkages

Table 3-2 Linkages

ExampleConventionType of Linkage

Single Chain:

MYC[*1]PEPC[*1]TIDE

Multi-chain:

LIGHTC[*1]HAIN /

MC[*2]HEAVYC[*1]HAINC[*2]AD

Add [*#] to both residues in the
bridge

S-S bridge

MYR[*1]PEPD[*1][O-1]TIDEAdd '[O-1]' to one of the
bonding residues

Ester/Amide Bridge

M[*1]YCPEPCTIDE[*1]-[H]Add '[H]' on the C-TermCyclic

[H]-C[*1]YCPEPCTIDC[*1]-[OH]Explicitly add the terminal
groups

Loops: Linked residue at first or
last index and the terminal
groups are not part of the
bridging bond
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Add an Oligonucleotide Sequence
Optionally, add oligonucleotide compound information to the compound library. Compounds in the
library have MS/MS spectra, which will be used during processing.

Note: If a compound is not in the library, then the user can add it to a processing method manually.

Sequences are added in text format. To capture the diverse set of therapeutic oligonucleotide
modifications and custom elements, obey the rules for inputting sequences. Refer to the section:
Oligonucleotide Sequence Naming Conventions. For a more detailed list of modifications and
custom elements, refer to the section: Custom Elements.

1. In the Workflow panel, click Compound Library.
2. Click New > Oligonucleoide Sequence.

The New Entry dialog opens.

3. Type the Name of the oligonucleotide sequence and then click OK.
4. Type the sequence in the Sequence table.

Note: The sequence can contain custom elements. Refer to the section: Custom Elements.

5. Click the Chemical formula field to automatically update the chemical formula.
6. (Optional) Type information into the fields on the Compound Details tab.

7. Click the Experimental Data tab.

8. Do one of the following:

• To add a reference MS/MS spectrum from a wiff file, continue with the section: Add a
Reference MS/MS Spectrum from a wiff File.

• To add a reference MS/MS spectrum from a txt file, continue with the section: Add a
Reference MS/MS Spectrum from a txt File.

Oligonucleotide Sequence Naming Conventions
Oligonucleotide sequences can be specified using characteristic single-letter identifiers for the
bases:

• Adenine (A)

• Cytosine (C)

• Thymine (T)

• Guanine (G)
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• Uracil (U)

Oligonucleotide types such as Deoxyribonucleic acid (DNA, d), Ribonucleic acid (RNA, r), can be
identified with the single-letter identifier added at the beginning of the sequence or, for mixed
oligonucleotide types, interspersed between bases.

For oligonucleotides that contain synthetic nucleotides, such as locked nucleic acid (LNA), use
the full symbol for each residue when defining the sequence. For example lA for LNA-A or moA
for 2'-Mehtoxymethyl-A.

Backbone modifications, such as phosphorothioate (HPSO, *), are added at the end of each base.

Heavy atoms, such as Carbon-13(/13Cn/), are added after the specific oligonucleotide residue,
where n denotes the number of heavy atoms.

Note: In the preceding example, the notation "/13Cn/" adds heavy atoms to the existing formula.
It does not replace atoms in the nucleobase with a heavy label. To define an isotopically labeled
nucleobase, a custom modification is required.

Use a slash (/) as the first and last character to identify a user-defined custom modification. To
add custommodifications, and for examples of additional use cases for modifications and associated
naming conventions, refer to the section: Custom Elements.

Table 3-3 Oligonucleotide Conventions

ExampleInput ConventionCharacteristic

dACG TdDNA

rACG UrRNA

dACG lTd, lMixed DNA and LNA

dA*C*G* T**Phosphorothioate backbone

moAmoCmoG moTmo2'Methoxymethyl (2'MOE) sugar
modification

dACG T/13C2//13Cn/Carbon-13

dACG /Other Residue///Custom residue

Add a Reference MS/MS Spectrum from a wiff File
1. Click Open wiff File.

The Select Data dialog opens.
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2. Browse to the appropriate location, select a wiff file that contains a spectrum for the
compound being added, and then click OK.

Note: The wiff file must contain the compound as a precursor ion.

Table 3-4 Add a Reference Spectrum

File contains one precursorFile contains multiple precursors

If the wiff file only contains one precursor,
then the MS/MS Spectrum window is
updated with the spectrum.

If there are multiple precursors in the
selected wiff file, then the Select a Spectrum
dialog opens with the following information
shown in the Precursors table for each
available precursor:

• m/z

• Time (min)

• Quality

• Charge

The software uses the m/z and the Charge
of the selected precursor, and the collision
energy of the experiment to create a unique
line of information in the Spectra field on the
Compound Library dialog. For example,
Prec(m/z), CE(collision energy from the
experiment), Charge(Charge) is shown in
the field.

The title of the spectrum contains the
Polarity and theCompound name from the
Compound Information group, followed by
the information from the Spectra field.
The Spectrum Details contain the
Instrument type, Retention time, Charge, and
Collision energy corresponding to the
selected MS/MS spectrum. This information
is read-only.

Select the check box for the filters to be
applied.

Select one or both filter options, as
applicable. The Precursors table updates
to show only the rows that meet the criteria
specified.
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Table 3-4 Add a Reference Spectrum (continued)

File contains one precursorFile contains multiple precursors

—Select a row in the Precursors table.

The MS/MS Spectrum window is updated
with the spectrum for the selected precursor.

Tip! Use Ctrl+click to select multiple rows.
If multiple rows are selected, then the
MS/MS Spectrum for the first selected
precursor is shown.

—If the Charge state from check box is
selected, then select the from and to values
from the options provided. The from value
is equivalent to the minimum available
charge state in the Precursors table. The to
value is equivalent to the maximum available
charge state shown in the Precursors table.

—If the Quality above check box is selected,
then type the appropriate value in the field
provided.
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Table 3-4 Add a Reference Spectrum (continued)

File contains one precursorFile contains multiple precursors

—Click OK.

—For each row selected in the Precursors
table, the software uses the m/z and the
Charge of the selected precursor, and the
collision energy of the experiment to create
a unique line of information in the Spectra
field on the Compound Library dialog. For
example, Prec(m/z), CE(collision energy from
the experiment), Charge(Charge) is shown
in the field.

The information shown in the Spectra field
and the spectrum shown in the MS/MS
Spectrum field corresponds to the first row
selected in the Precursors table.

The title of the spectrum contains the
Polarity and theCompound name from the
Compound Information group, followed by
the information from the Spectra field.
The Spectrum Details contain the
Instrument type, Retention time, Charge, and
Collision energy corresponding to the
selected MS/MS spectrum. This information
is read-only.

3. (Optional) Select a different Spectra from the list provided.

The MS/MS Spectrum and the Spectrum Details are updated to show the information
related to the selection.

4. To save a spectrum as the predefined spectrum for the compound, select the appropriate
Spectra from the list provided and then click Set as Reference.
- Reference is added to the information shown in the Spectra field. For example, Prec
(xx.xx), CE(xx), Charge(xx) - Reference is shown in the field.

5. Click Save.
6. Click OK.

The new compound is saved in the library and the Compound Library dialog closes.
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Add a Reference MS/MS Spectrum from a txt File
1. Click Open txt File.

The Open txt File dialog opens.

2. Browse to the appropriate location, select an MS/MS txt file, and then click OK.
The Spectrum Details dialog opens.

3. Type the appropriate information for the selected spectrum and then click OK.
The software uses the information in the Precursor mass (m/z), Collision energy, and
Charge fields to generate the information in the Spectra field on the Compound Library
dialog. For example, Prec (Precursor mass (m/z)), CE(Collision energy), Charge(Charge)
is shown in the field.

The information shown in the Spectra field and the spectrum shown in theMS/MSSpectrum
field corresponds to the selected txt file.

The title of the spectrum contains thePolarity and theCompound name from the Compound
Information group, followed by the information from the Spectra field.
The Spectrum Details contain the Instrument type, Retention time, Charge, and Collision
energy corresponding to the selected MS/MS spectrum. This information is read-only.

4. (Optional) Select a different Spectra from the list provided.

The MS/MS Spectrum and the Spectrum Details are updated to show the information
related to the selection.

5. To save a spectrum as the predefined spectrum for the compound, select the appropriate
Spectra from the list provided and then click Set as Reference.
- Reference is added to the information shown in the Spectra field. For example, Prec
(xx.xx), CE(xx), Charge(xx) - Reference is shown in the field.

6. Click Save.
7. Click OK.

The new compound is saved in the library and the Compound Library dialog closes.

Add Information to the Compound Library from a
Results Table
Note: This functionality is only available for small molecule and peptide Results files. The
functionality is not available for ADC and oligonucleotide Results files.
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1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Select a row in the Potential Metabolites table, right click, and then selectAdd to Compound
Library.

Note: If the selected row does not contain an MS/MS spectrum, the Add to Compound
Library option is not available.

6. Click OK in response to the confirmation message.

7. In the Workflow panel, click Compound Library.
The Compound Library dialog opens. The added metabolite is added to the Compound
name list.
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Biotransformation sets are lists of common transformations.

About Biotransformations
Users can search for predicted metabolites using predefined biotransformation sets that are
installed with the software, or they can create new biotransformation sets. For example, users
might want to create a different set for each compound being analyzed. The installed
biotransformations contain embedded information that is used during automated sequence or
structure proposal.

Method-specific biotransformation sets are used as defaults for each method type. For example,
the peptides method uses the biologics biotransformation set as its default. This biotransformation
set contains the most relevant biotransformations for in-vivo metabolic reactions for peptides.

For oligonucleotides, select one of three predefined transformation sets:

• Oligonucleotide Basic: Provides a concise list of modifications and is restricted to those
impacting the base or the backbone only.

• Oligonucleotide Comprehensive: Provides extensive coverage of all transformations that can
occur during synthesis, in-vivo metabolism, and storage.

• Oligonucleotide Metabolites: Contains a subset of the comprehensive set that focuses on
in-vivo transformations only.

Consider the origin of the sample carefully and then choose the most representative set. Users
can build their own custom biotransformation set from default entries, or by adding new entries.
Refer to the sections: Create a Biotransformation Set and Edit a Biotransformation Set.

Create custom biotransformations by identifying a change in chemical formula or by combining
two existing biotransformations.

Custom biotransformations or biotransformations from existing sets can be included in any new
biotransformation set that is created.

Tip!When assessing biologics data, select highly probable biotransformations to create a small
set for faster analysis of the data.
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Create a Biotransformation Set
1. In the Workflow panel, click Biotransformations.

The Biotransformations dialog opens.

2. Click New.
The New Biotransformation Set dialog opens.

3. Type a name for the set in theWorking biotransformation set field.
4. Click New Biotransformation.

The New Biotransformation dialog opens.

5. Type a name for the biotransformation in the Name field.
6. (Optional) Type the appropriate details related to the biotransformation in the Description

and Comments fields.
7. Do one of the following:

Table 4-1 Create Biotransformation Sets

To create a combined biotransformationTo create a single biotransformation

Click Combined biotransformation.Click Single biotransformation.

Select a biotransformation from each of the
Biotransformation 1 and
Biotransformation 2 fields.

Identify the portion of the structure being lost
in the Formula from field.

—Type the formula of the biotransformation in
the Formula to field.

Note: The available biotransformations are those that exist in the working set.

Note: The software automatically calculates the change resulting from the biotransformation
and populates the Mass shift field with this value.

8. Click OK.
The new biotransformation is shown in both the working biotransformation set and the
source biotransformation set tables.

9. Click OK to save the new biotransformation set.

The New Biotransformation Set dialog closes.
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10. Click OK.
The Biotransformations dialog closes.

Edit a Biotransformation Set
1. In the Workflow panel, click Biotransformations.

The Biotransformations dialog opens.

2. Select the appropriate Set from the list provided.

3. Click Edit.
The Edit Biotransformation Set dialog opens showing the name of the selected set in the
Working biotransformation set field.

4. Type a name for the appropriate set in theWorking biotransformation set field.
5. Select a row in the working biotransformation set table.

6. Click Edit Biotransformation.
The Edit Biotransformation dialog opens.

7. (Optional) Make any required changes in the Name, Description, and Comments fields.
8. (Optional) Do one of the following:

Table 4-2 Edit Biotransformation Sets

To create a combined biotransformationTo create a single biotransformation

Click Combined biotransformation.Click Single biotransformation.

Select a biotransformation from each of the
Biotransformation 1 and
Biotransformation 2 fields.

Identify the portion of the structure being lost
in the Formula from field.

—Type the formula of the biotransformation in
the Formula to field.

Note: The available biotransformations are those that exist in the working set.

9. Click OK.
The updated biotransformation is shown in both the working biotransformation set and the
source biotransformation set.

10. Click OK to save the changes.
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The Edit Biotransformation Set dialog closes.

11. Click OK.
The Biotransformations dialog closes.

Delete a Biotransformation Set
1. In the Workflow panel, click Biotransformations.

The Biotransformations dialog opens.

2. Select the appropriate Set from the list provided.

3. Click Delete.
A confirmation message opens.

4. Click Yes.
5. Click OK.

The Biotransformations dialog closes.
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The software supports four workflows: small molecule, peptide, oligonucleotide, and ADC.

A method containing processing parameters that are specific to the sample file being studied must
be created to find potential metabolites in a sample of interest.

Select the Method Type

Select Parameter Values

Set Generic Processing Parameters

Set Compound-Specific Processing Parameters

Processing Parameters
The processing parameters in the Molecule Profiler software contain all of the attributes and values
that allow wiff files to be processed. The processing function is used to find and characterize
metabolites. The processing function also assigns confidence scores to metabolites.

These processing parameter templates are used:

• Small molecule

• Peptides

• Oligonucleotides

• ADC

The templates represent the compound and workflow types that are considered for the different
types of analysis.

Note:When adding compound sequences, make sure that the sequence names are formatted
correctly. Refer to the sections: Peptide Sequence Naming Conventions or Oligonucleotide
Sequence Naming Conventions.
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Select the Method Type
1. In the Workflow panel, click Processing Parameters.

The processing parameters workspace opens.

2. Click New and then select the method type from the list provided.

3. Continue with step 2 of Select Parameter Values.

Select Parameter Values
1. In the Workflow panel, click Processing Parameters.

The Processing Parameters workspace opens.

2. Type the Compound Information in the Processing Parameters workspace.

• For small molecule and ADC workflows, click Open Structure in the Structure group,
select the targeted mol file, and then import the structure.

• For peptide and oligonucleotide workflows, type the appropriate sequence in the Sequence
group.

Tip! Alternatively, click Select From Library to select an entry from the compound library
to fill in the structure or sequence. Only entries that match the workflow are available in
the list. Refer to the section: Select a Compound from a Library.

3. Make sure that the Polarity, Charge state, and Adduct or Ion type are appropriate for the
data set.

Oligonucleotides are typically acquired in negative polarity or negative ion mode. The
recommended charge range for oligonucleotides with masses of 10,000 Da or less is –2 to
–20. Processing of oligonucleotides with masses greater than 10,000 Da is not
recommended.

4. Select the peak finding strategies to use when finding potential metabolites. Refer to the
section: About Peak Finding Strategies.

5. Configure the parameters that are independent of the compound being processed. Refer
to the section: Generic Processing Parameters.

6. Configure the parameters that are dependent on the compound. Refer to the section:
Compound-Specific Processing Parameters.

7. Click Save and Close.
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8. Select the method storage location in the Folder field of the Save Processing Parameters
As dialog.

9. Type a name for the method in the Name field and then click OK.
The method is saved and the Processing Parameters workspace closes.

Select a Compound from a Library

1. In the Workflow panel, click Processing Parameters.
The processing parameters workspace opens.

2. Click Select From Library.
The Select From Library dialog opens.

3. Select a compound from the list in the Compound name field.

Note: For small molecule and ADC processing parameters, only the entries identified as
structures in the compound library are shown in the list. For peptide and oligonucleotide
processing parameters, only the entries identified as sequences in the compound library
are shown in the list.

4. Click OK.
The processing parameters workspace is updated with the information from the selected
compound.

5. To review or edit the reference MS/MS spectrum, click Compound-Specific Parameters
> Product Ions and Neutral Losses.

Note: The Reference MS/MS Spectrum pane is populated with the MS/MS spectrum from
the selected compound.

6. (Optional) If multiple reference spectra are available, then navigate through the list and
select a different spectrum, if appropriate.

Note:When a different reference spectrum is selected, the Reference MS/MS Spectrum
pane is refreshed and the information is cleared from the product ions and neutral losses
table.

7. To configure the fragments table, click Assign Fragments.
8. Continue with step 5 of the section: Select Parameter Values.
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About Peak Finding Strategies
Peak finding strategies refer to the algorithms the software uses to find potential metabolites in
the sample of interest. Users can select specific algorithms in the Peak Finding Strategy group to
process the data.

DescriptionAlgorithm

TOF MS

• Small molecule: With this algorithm, the software searches for
metabolites based on the selected biotransformation set, the
predicted cleavage metabolites, and a combination of the two.

• Peptides: With this algorithm, the software searches for
metabolites based on the biotransformation set, the predicted
catabolites, and a combination of the two.

• Oligonucleotides: With this algorithm, the software searches for
metabolites based on the biotransformation set, the predicted
catabolites (including hydrolytic cleavage, terminus n+1 and
internal n–1 products), and a combination of the two.

• ADC: With this algorithm, the software searches for metabolites
based on biotransformations, cleavages, antibody fragments, and
a combination of the three.

Refer to the section: Generic Processing Parameters. For each
method, the Available Adducts selected in the MS Parameters tab
are also included when using the combinations.

Note: The Predicted metabolites option is recommended for
processing of oligonucleotide data.

Predicted metabolites

With this algorithm, the software searches for unexpectedmetabolites.
The search can be refined further by selecting theApplymass defect
filter or the Apply charge state filter.
The parameters that control this algorithm are found on the
Chromatographic Data and MS Parameters tabs. Refer to the
section: Generic Processing Parameters.

Note: This option, in conjunction with the Predicted metabolites
option, is recommended for processing of oligonucleotide data.

Generic peak finding
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DescriptionAlgorithm

This filter restricts the search to peaks that exhibit the filters selected
on the Mass Defect range specified in the Compound-Specific
Parameters. When this filter is selected, only those metabolites found
by the generic peak finder that meet the criteria specified are included
in the results.

Apply mass defect filter

This filter restricts the search to peaks with a charge that is within
the Charge state tab in the Compound Information group. When this
filter is selected, only those metabolites found by the generic peak
finder that meet the criteria specified are included in the results.

Note: This option is not recommended for processing oligonucleotide
data.

Apply charge state filter

This algorithm is only applicable to small molecule methods.

This algorithm uses fractional mass to filter the data. The compound,
selected biotransformations, and potential cleavage metabolites all
contribute to the available filters that allow users to search for specific
metabolites within a range of masses.

The parameters that control this algorithm are found on the Mass
Defect tab. Refer to the section: Compound-Specific Processing
Parameters.

Mass defect

This algorithm searches for metabolites that have an isotope pattern
similar to the parent compound.

Tip! If the compound is radio-labeled, then users can define the
isotopic enrichment on the Processing Parameters dialog, by
selecting Compound-Specific Parameters > Isotope Pattern.

The parameters that control this algorithm are found on the Isotope
Pattern tab. Refer to the section: Compound-Specific Processing
Parameters.

Isotope pattern

TOF MSMS

Note: This algorithm works only if the processing parameter method contains a reference
MS/MS spectrum. The reference MS/MS spectrum can be from the entry in compound library,
or it can be added manually on the Product Ions and Neutral Losses tab. Refer to the section:
Compound-Specific Processing Parameters.
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DescriptionAlgorithm

The software uses this algorithm to search the IDA data and the
SWATH acquisition data for metabolites that have characteristic
product ions to the parent compound.

With this algorithm, users can search for all or a limited number of
the identified ions.

The parameters that controls this algorithm are found on the Product
Ions and Neutral Losses tab. Refer to the section: Compound-Specific
Processing Parameters.

Find characteristic
product ions

When this option is selected, all of the identified ions are searched.
For example, if four product ions are identified and then a search for
peaks that have all of these ions is conducted, then only exact
matches are identified as potential metabolites.

All specified ions

When this option is selected, only the ions selected on the Product
Ions and Neutral Losses tab are searched. For example, if the search
is for peaks with at least two ions, then at least two ions out of the
selected ions must be present in the MS/MS spectrum of the
metabolite before a peak can be considered a metabolite.

At least __ ions

The software uses this algorithm to search the IDA data and the
SWATH acquisition data for metabolites that have neutral losses to
the parent compound. The algorithm is not applicable to peptide and
oligonucleotide workflows.

With this algorithm, users can search for all or a limited number of
losses. For example, if four neutral losses are identified and then a
search for peaks that have all of these losses is conducted, then only
exact matches are identified as potential metabolites. If the search
is for peaks with at least two losses, then at least two of the selected
losses must be present in the MS/MS spectrum of the metabolite
before a peak can be considered a metabolite.

The parameters that control this algorithm are found on the Product
Ions and Neutral Losses tab. Refer to the section: Compound-Specific
Processing Parameters.

Find characteristic
neutral losses

When this option is selected, all metabolites are searched and all
neutral losses are reported.

All specified losses
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DescriptionAlgorithm

When this option is selected, only the losses selected on the Product
Ions and Neutral Losses tab are searched. For example, if four neutral
losses are identified and a search for peaks that have all of these
losses is conducted, then only exact matches are identified as
potential metabolites. If the search is for peaks with at least two
losses, then at least two of the selected losses must be present in
the MS/MS spectrum of the metabolite before a peak can be
considered a metabolite.

At least __ losses

This algorithm is specific to SWATH acquisition data.

This strategy will only work if at least two neutral losses are selected.
The internal neutral loss is the delta between the two neutral losses
formulas. Note that one neutral loss formula needs to be a subset of
the other neutral loss formula in order for the "Find by Internal Neutral
Loss" to take effect

Consider internal neutral
losses

This algorithm is specific to SWATH acquisition data.

Precursors with a fragment isotope pattern that matches the fragment
isotope pattern selected in the table on the Product Ions and Neutral
Losses tab in the Compound-Specific Parameters are flagged as
metabolites. The user must select one or more of the fragment isotope
formula check boxes in the Isotope Pattern column. The experimental
fragment isotope pattern must match the theoretical fragment isotope
pattern within the MS/MS m/z tolerance and Intensity Tolerance
specified on the MS/MS Parameters tab, in order for the peak to be
considered a metabolite.

Isotope pattern (SWATH
Only)

Generic Processing Parameters
Generic parameters are settings that are independent of the compound being processed. Each
of the following tabs manage generic parameters:

Generic Parameters

ADCOligonucleotidesPeptidesSmall Molecules
Biotransformations TabBiotransformations TabBiotransformations TabBiotransformations Tab

Chromatographic Data
Tab

Chromatographic Data
Tab

Chromatographic Data
Tab

Chromatographic Data
Tab

MS Parameters TabMS Parameters TabMS Parameters TabMS Parameters Tab
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MS/MS Parameters
Tab

MS/MS Parameters
Tab

MS/MS Parameters
Tab

MS/MS Parameters
Tab

Formula Prediction Tab
(Small Molecule and
ADC Methods)

Confirmation Scoring
Tab

Confirmation Scoring
Tab

Formula Prediction Tab
(Small Molecule and
ADC Methods)

Confirmation Scoring
Tab

Confirmation Scoring
Tab

Biotransformations Tab

Identifies the biotransformation set that contains the expected biotransformations. The software
includes predefined biotransformation sets. To create a custom biotransformation set, refer to the
section: Create a Biotransformation Set.

DescriptionParameter

Selects a different biotransformation set, to be used for processing, from the
database.

When this option is selected, the software might show the following warning:
"The selected biotransformation set might no longer exist in the
biostransformations database." This occurs because the selected
biotransformation set has been saved to the processing parameters file.
Subsequent changes made to the biotransformations set in the
Biotransformations workspace are not to saved to the processing parameters
file.

To reprocess using the saved biotransformation set, click OK, and then click
Cancel on the Biotransformations dialog. To update the processing parameters
file with a new biotransformation set, do this:

a. Click OK.
b. Select a biotransformations set.

A message is shown: "If you select this new biotransformation set, you
might not be able to re-select the existing set. Do you want to continue?

c. Click OK.

Select Set
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Chromatographic Data Tab

DescriptionParameter

Chromatographic Peak

Specifies the range of retention times to search for potential metabolites. The
size of the retention time (RT) window is directly proportional to processing
time.

Specify a value larger than 0.00 min to exclude the void volume of the column.

The to value must be greater than the from value.

We recommend that an RT window be set for all workflows, because a wide
RT range can increase processing times very much. Ranges are highly
dependent on the experiment being analyzed. Examine the RT window for
each experiment. We recommend that the start time be slightly greater than
0.00 min, and that the end time be slightly after the peak of interest, or when
the method enters the high elution or wash phase of the gradient.

Retention time
window

Specifies the method for setting the XIC width.
• XIC width: Specifies the width of the extracted ion chromatogram to be

considered for processing.

• Automatic: The software calculates the best width based on the selected
data.

The Automatic setting is recommended for oligonucleotide workflows.

Note: If this option is selected when SWATH acquisition data is being
processed, then the XIC width option is applied.

MS data

Determines how closely eluting peaks are integrated. This parameter also
handles chromatographic peaks with significant tailing.

Set this parameter lower if there are closely eluting peaks. The lower setting
allows peaks to be considered separately instead of as one peak.

LC peak
separation

TOF MS

Excludes chromatographic peaks that have a width below this value.

Set the value lower to include narrow peaks.

Minimum peak
width
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DescriptionParameter

Removes chromatographic peaks that are below a given TOF MS intensity
level from consideration.

Use when there is noisy chromatographic data. By setting a threshold just
above the level of noise, peaks that are likely the results of noise can be
rejected.

Examine peaks widths before processing data in theMolecule Profiler software
or in viewer software, such as the Explorer workspace in SCIEX OS. Use a
general average of all peaks examined to calculate the minimum peak width.

For oligonucleotide methods that contain TOF MS or IDA experiments, a
setting of 50 cps is recommended.

Minimum peak
intensity

Distinguishes peaks from noise by eliminating the variation in intensity within
noise.

Select when there is noisy chromatographic data.

This option is recommended for oligonucleotide workflows.

Use smoothing

Aligns the MS sample and control chromatograms. During processing, the
software shifts all controls before comparing them to the sample.

Sample-control
offset

Specifies how many times larger a sample peak must be when compared to
the control in order to be considered a metabolite.

Sample/control
ratio

TOF MS/MS

This parameter is only used when processing SWATH acquisition data, with
the MS/MS peak finding algorithms. This parameter is not used when
processing IDA data.

Removes chromatographic peaks that are below a given TOFMS/MS intensity
level from consideration.

Use when there is noisy chromatographic data. By setting a threshold just
above the level of noise, peaks that are likely the results of noise can be
rejected.

Minimum peak
intensity

Analog data

Selects the wavelength to use when confirming potential metabolites.Wavelength (UV
only)
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DescriptionParameter

Aligns the MS and analog chromatographic data. During processing, the
software shifts the analog data before comparing it with the MS data.

Note: The MS and analog chromatographic data can also be aligned, post-
processing, in the Analog Interpretation workspace. Refer to the section:
Change R.T. Offset.

Time offset from
MS

Determines how closely eluting peaks are integrated. This parameter also
handles chromatographic peaks with significant tailing.

Set this parameter lower if there are closely eluting peaks. The lower setting
allows peaks to be considered separately instead of as one peak.

LC peak
separation

Excludes chromatographic peaks that have a width below this value.

Set the value lower to include narrow peaks.

Minimum peak
width

Removes chromatographic peaks that are below a given intensity level from
consideration.

Use when there is noisy chromatographic data. By setting a threshold just
above the level of noise, peaks that are likely the results of noise can be
rejected.

Minimum peak
intensity

Distinguishes peaks from noise by eliminating the variation in intensity within
noise.

Select when there is noisy chromatographic data.

Use smoothing

Aligns the MS sample and control chromatograms. During processing, the
software shifts all controls before comparing them to the sample.

Sample-control
offset

MS Parameters Tab

DescriptionParameter

m/z Tolerance

Specifies a range for determining peaks in the MS spectrum. All masses within
this range will be considered one unique peak. For a peak with an assigned
experimental formula to be considered as a potential metabolite, the mass
accuracy of the peak must be within the tolerance specified.

This parameter is highly dependent on the calibration state of the instrument.
For instruments calibrated within ±3 ppm, a value of 10 ppm is recommended
for oligonucleotide methods that contain TOF MS or IDA experiments.

MSm/z tolerance
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DescriptionParameter

Specifies the minimum spectral threshold for MS peak intensity. Removes
MS peaks that have an intensity below the specified spectral threshold from
consideration.

Set the value based on the level of noise in the spectra.

Minimum MS
peak intensity

Isotope Pattern Tolerances

Specifies the tolerance that is applied to the isotope pattern of metabolites.
Only peaks with isotope m/z offset values that are within this tolerance are
considered a match.

For oligonucleotide methods that contain TOF MS or IDA experiments, a
value of 10 mDa is recommended.

MSm/z tolerance

Specifies the relative tolerance for the isotopic intensities as defined on the
Isotope Pattern tab in the Compound-Specific Parameters. To be considered
a match, the intensity ratio of two peaks must equal the expected ratio within
this tolerance.

For oligonucleotide methods that contain TOF MS experiments, a value of
20% is recommended.

Intensity
tolerance

(Oligonucleotide methods) Specifies the minimum matching tolerance (in
percent) for the observed isotope pattern for a metabolite, when compared
to its expected isotope pattern. We recommend starting with a value of 0%,
and then increasing the value as required to remove confirmed false positive
identifications.

Minimum Score

Limits

Select a maximum number of unexpected peaks that can be identified as
potential metabolites.

This setting affects the maximum number of peaks that can be identified by
the generic peak finder. The generic peak finder interacts with the predicted
metabolites peak finder. For example, if a smaller biotransformation set is
selected for a complex sample, then the maximum number of unexpected
metabolites will be high, and thus this setting will need to be increased.
Typically, for process impurity oligonucleotide samples, a setting of 100 is
recommended. For more complex samples this number should be increased.

Maximum
number of
unexpected
metabolites

Limits the mass range in which to find potential metabolites.Mass range
window (m/z)

Generic LC/MS Peak Finding
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DescriptionParameter

Specifies if background subtraction is to be performed. Select this option to
remove the background ions if the background level is high in the LC/MS
chromatogram.

For oligonucleotide methods that contain TOF MS and TOF MS/MS
experiments, this option is not recommended.

Perform
background
subtraction

Available Adducts (Small molecule methods)
A list of all of the supported adducts, based on the charge range defined in the Compound
Information group.

Indicates whether the adducts are to be included in the search.Use

(Read-only) Indicates the number of adducts that have been selected in the
Use column of the Available Adducts table.

__ adduct(s)
selected

Advanced Ion Types (ADC, peptide, and oligonucleotide methods)

Indicates if the ions are to be included in the search.Use

(Read-only) Indicates the number of ions that have been selected in the Use
column of the Advanced Ion Types table.

__ adduct(s)
selected

MS/MS Parameters Tab

DescriptionParameter

MS/MS Finding

Specifies a range for determining peaks in the MS/MS spectrum. The MS/MS
m/z tolerance is the tolerance within which found fragment peaks in theMS/MS
spectrummust match the selected fragments or neutral losses values specified
on the Product Ions and Neutral Losses tab in the Compound-Specific
Parameters so that the corresponding precursor peak can be considered a
potential metabolite.

For oligonucleotide methods that contain TOF MS/MS or IDA experiments,
a value of 10 mDa is recommended.

MS/MS m/z
tolerance

Removes from consideration MS/MS peaks that have an intensity below the
specified spectral threshold.

Set the value based on the level of noise in the spectra.

MinimumMS/MS
peak intensity

MS/MS Isotope Finding
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DescriptionParameter

Specifies a range for determining peaks in the MS/MS spectrum. For peaks
in the MS/MS spectrum to be considered a match, the mass difference
between two isotopic peaks must equal the expected difference within this
tolerance.

The MS/MSm/z tolerance is used when processing SWATH acquisition data
with the Isotope pattern (SWATH only) peak finding strategy selected.

For oligonucleotide methods that contain TOF MS/MS or IDA experiments,
a value of 10 mDa is recommended.

MS/MS m/z
tolerance

Specifies the relative tolerance around the isotopic intensities of the selected
fragment formulas as defined in the selected IP cell on the Product Ions and
Neutral Losses tab in the Compound-Specific Parameters. To be considered
a match, the intensity ratio of two peaks must equal the expected ratio within
this tolerance. This parameter also defines the smallest isotope that is
considered part of the pattern. For example, if the intensity tolerance is 10%,
then the smallest isotope that can contribute to the mass pattern must be
10% or higher of the 100%-defined peak.

The Intensity tolerance is used when processing SWATH acquisition data
with the Isotope pattern (SWATH only) peak finding strategy selected.

For oligonucleotide methods that contain TOF MS/MS or IDA experiments,
a value of 20% is recommended.

Intensity
tolerance

Source of Reference MS/MS Spectrum

Select a reference spectrum for the compound of interest. The spectrum can
be selected from various locations.

Control

Sample
Selected reference spectrum is selected by default.

Selected
reference
spectrum

We recommend that the Selected reference spectrum option is chosen
when using the automatic structure or sequence generation function.

MS/MS Spectrum

This filter is used exclusively for SWATH acquisition data. The algorithms
used by this filter include PCVG which is used to assign fragments from an
MS/MS spectrum to a particular precursor for SWATH acquisition data, Only
those fragments that can confidently be assigned to the precursor are shown
in the MS/MS spectrum, depending on the position of the slider
(Comprehensive or Confident).

Use advanced
MS/MS filter

Similarity and Fragment Interpretation
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DescriptionParameter

Select a mass accuracy tolerance to compare the reference MS/MS spectrum
to the MS/MS spectrum of the metabolite. This parameter is also used when
fragments are assigned in the Interpretation table. The mass accuracy of the
assigned fragments must be within the MS/MS m/z tolerance provided.

For oligonucleotide methods that contain TOF MS/MS or IDA experiments,
a value of 10 ppm is recommended.

MS/MS m/z
tolerance

Select a minimum ratio of signal to unwanted noise to compare the reference
MS/MS spectrum to the MS/MS spectrum of the metabolite. This parameter
is also used when fragments are assigned in the Interpretation table. The
signal to noise ratio of the assigned fragments must be above the minimum
signal to noise ratio provided.

Minimum
signal-to-noise
ratio

Fragment Interpretation Options (Small Molecule and Peptide Methods)

(Small molecule methods) Specifies number of MS/MS fragments that will be
selected for assignment. The peaks are selected based on their intensities
(the more intense peaks are selected first).

Number of
fragment peaks
selected for
assignment

(Small molecule methods) Breaks bonds that form part of an aromatic ring.Break aromatic
rings

(Small molecule methods) Specifies the maximum number of bonds to break
when assigning MS/MS fragments for interpretation.

Maximum
number of bonds
to break

(Small molecule methods) Specifies the maximum number of C-C bonds to
break when assigning MS/MS fragments for interpretation.

Maximum
number of C-C
bonds to break

(Peptide methods) Identifies the fragment type. Multiple types can be selected.Fragment Types

(Peptide methods) Specifies the maximum number of bonds to break.Maximum bonds
to break

(Peptidemethods) Breaks linkages in the peptide or oligonucleotide sequence.Break linkages

Formula Prediction Tab (Small Molecule and ADC Methods)

DescriptionParameter

Search Constraints

Specifies the starting element that the software will use to propose formulas
for potential metabolites.

Elements from
Elements to
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DescriptionParameter

Isotope Pattern Tolerances

After the software identifies a theoretical predicted isotope pattern for a
proposed formula, this parameter limits the allowed mass difference between
isotopes when compared to the isotope pattern of the metabolite.

MSm/z tolerance

After the software identifies a theoretical predicted isotope pattern for a
proposed formula, this value limits the allowed difference in isotopic peak
intensity when compared to the isotope pattern of the metabolite.

Intensity
tolerance

Ranking

Specifies whether formulas based on theMS spectrum or based on theMS/MS
spectrum should be provided in the results.

Contribution

Select to apply a logarithmic scale to the MS/MS weighting.Automatically
weight MS/MS

Rings and Double Bonds

Identifies a range of rings and double bonds in the proposed formulas of
potential metabolites.

If the number of rings and double bonds of a proposed formula does not fall
within the specified range, then that formula will not be considered for the
metabolite.

The minimum value must be less than the maximum value.

RDB from
RDB to

Element Ratios

Specifies the range of oxygen-to-phosphorus molecules that must be present
in the proposed formulas.

This parameter applies to both MS and MS/MS formulas.

Oxygen/
phosphorus
count

Specifies the range of oxygen-to-sulphur molecules that must be present in
the proposed formulas.

This parameter applies to both MS and MS/MS formulas.

Oxygen/sulphur
count

Confirmation Scoring Tab

When a potential metabolite is found in the sample of interest, the software assigns a confirmation
score that indicates the likelihood that the peak found is a metabolite. The score is independent
of the algorithms used to find metabolites and is based on various properties.

Note: For oligonucleotide methods, a value of 100 is recommended for Isotope pattern, and 0
for all other parameters.
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DescriptionParameter

(Small molecule methods) Indicates how closely the mass defect of the
metabolite matches the mass defect of the parent compound, potential
cleavage metabolites, or Phase II metabolites.

Note: This attribute is not used for the calculation of the total confirmation
score for ADC, peptide, and oligonucleotide data.

Mass defect

(Small molecule and ADC methods) Indicates whether the metabolite has an
isotope pattern similar to the parent compound. This property has a score
from 0 to 100.

(Oligonucleotide methods) Indicates whether the metabolite has an isotope
pattern similar to the expected isotope pattern. This parameter is very useful
for filtering false positives. A value of 100 is recommended.

Isotope pattern

Indicates how close the MS/MS spectrum is to the reference spectrum. This
property applies only if a reference spectrum is available.

The MS/MS score has two components:

• Quality: A measure of the ability to distinguish spectral peaks from
background noise.

• Similarity: The software calculates how close the MS/MS spectrum is to
the reference spectrum, including product ions that were shifted based on
known biotransformations.

Note: If only TOF MS data is being processed, then set this parameter to
0.

MS/MS

Indicates how close the found m/z value is to the expected m/z value. This
property applies for predicted metabolites only.

Mass accuracy

(Read-only) Total of the four property values.Total
confirmation
score

Tip! Type 0 in the Scoring table to ignore a specific property when scoring.

Compound-Specific Processing Parameters
Compound-specific processing parameters are settings that are dependent on the compound
being processed. Each of the following tabs manage compound-specific parameters.
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Compound-Specific Parameters

ADCOligonucleotidesPeptidesSmall Molecules
Cleavage Metabolites
Tab (Small Molecule
and ADC Methods)

Catabolites Tab
(Oligonucleotide
Methods)

Catabolites Tab
(Peptide Methods)

Cleavage Metabolites
Tab (Small Molecule
and ADC Methods)

Isotope Pattern TabIsotope Pattern TabIsotope Pattern TabMass Defect Tab
(Small Molecule
Methods)

Product Ions and
Neutral Losses Tab

Product Ions and
Neutral Losses Tab

Product Ions and
Neutral Losses Tab

Isotope Pattern Tab

Antibody DetailsProduct Ions and
Neutral Losses Tab

Cleavage Metabolites Tab (Small Molecule and ADC Methods)

Identifies the potential cleavage metabolites of the parent compound. The method must contain
a structure before the software can generate a list of potential cleavage metabolites.

DescriptionParameter

Potential Compound Cleavages

Specifies the maximum number of bonds to break.Maximum bonds
to break

Breaks bonds that form part of a ring.Break ring bonds

Breaks only C-N bonds.Only break C-N
bonds

Indicates the number of cleavages that have been selected in the potential
compound cleavages table. Automatically generated by the software.

Cleavages
selected

Catabolites Tab (Peptide Methods)

Identifies the potential hydrolytic cleavages of the parent compound. The method must contain a
peptide sequence before the software can generate a list of potential hydrolytic catabolites.

Software User GuideMolecule Profiler Software
RUO-IDV-05-12707-A54 / 166

Create Processing Methods



DescriptionParameter

Potential Hydrolytic Cleavages

Specifies the maximum number of peptide bonds to break.Max. peptide
bonds to break

Specifies the maximum number of cross-links to break.Max. cross-links
to break

Specifies the minimum number of amino acids in the catabolite.Min. AA count

(Read-only) Indicates the number of catabolites that have been selected in
the potential hydrolytic cleavages table.

Catabolites
selected

Catabolites Tab (Oligonucleotide Methods)

Identifies the potential hydrolytic cleavages of the parent compound. The method must contain a
peptide sequence before the software can generate a list of potential hydrolytic catabolites.

DescriptionParameter

Potential Hydrolytic Cleavages

Specifies the maximum number of bonds that can break along the
oligonucleotide backbone only, including loss of H2PO3. For nucleobase and
sugar losses, refer to the section: Biotransformations Tab.

Max. bonds to
break

Specifies the minimum number of nucleotides used to generate potential
catabolites and hydrolytic cleavages.

Min. Nucleotides

Specifies whether to search for terminus n+1 impurities.Include terminus
n+1 sequences

Specifies whether to search for internal n–1 impurities.Include internal
n-1 sequences

(Read-only) Indicates the number of catabolites that have been selected in
the potential hydrolytic cleavages table.

Catabolites
selected

Mass Defect Tab (Small Molecule Methods)

When complex biological samples are analyzed, these filters can help to remove background
interference.
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DescriptionParameter

Mass Defect Filters

Indicates the number of mass defect filters that have been selected
in the mass defect filters table. Automatically generated by the
software.

Filters selected

Filters

Selected by default.Parent

Selected by default.Glucuronidation

Selected by default.Bis-Glucuronidation

Selected by default.Glutathione

Selected by default.Sulphate

Isotope Pattern Tab

DescriptionParameter

Shows a graphical representation of the information listed in the Isotopes
table.

(Oligonucleotide methods) Shows a graphical representation of the isotopic
distribution for the oligonucleotide, at a specified charge state. To change the
charge state, select a different Ion type in the Compound Information.

Isotope Pattern

Specifies the isotopic enrichment of an atom that will be used in the formula
of the parent compound.

Note: To add an isotope element for ADC or small molecule methods, import
the mol file that contains the isotope.

Note: To change the isotopic enrichment for peptide and oligonucleotide
formulas with enriched atoms, refer to the section: Edit the Isotopic
Enrichment for Peptide and Oligonucleotide Formulas.

Isotopic
Enrichment

Shows the most intense isotopes, based on the formula and isotopic
enrichment, if applicable, of the parent compound.

Isotopes

(Oligonucleotide methods) Specifies the cutoff value, in percent intensity, that
is applied during peak area calculation to individual isotopes that are
considered for XIC extraction. Isotopes with intensities below the cutoff are
shown in red in the table.

Isotope Pattern
Intensity Cufoff
for Metabolite
XICs (%)
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Product Ions and Neutral Losses Tab

DescriptionParameter

Identifies a spectrum to use when selecting product ions and neutral losses
to match against the MS/MS of potential metabolites. The best source is a
data file for a sample acquired under similar conditions as the sample of
interest.

The spectrum can be selected from one of two locations:

• wiff file

• Compound Library

Reference
MS/MSSpectrum

Filters

Defines the mass range that is considered when populating the product ions
and neutral losses table. Only the fragments that are within the selected range
are shown in the product ions and neutral losses table.

m/z From __ to
__

Defines the charge state range that is considered when populating the product
ions and neutral losses table. Only fragments with charges that are within the
selected range are shown in the product ions and neutral losses table.

Charge state
From __ to __

Defines the minimum threshold for product ions to be included in the product
ions and neutral losses table. Removes product ions that are below the given
intensity from consideration.

Only show
product ions
above (%)

Only fragments with mass accuracies that are within the specified value are
shown in the product ions and neutral losses table.

Mass accuracy
within (mDa)

(Small molecule and ADCmethods) Includes product ions and neutral losses
from phase II metabolites in the product ions and neutral losses table.

Add product
ions, neutral
losses from
Phase II
metabolites

Note: After all of the required changes have been made to the filters, click Assign Fragments
to update the product ions and neutral losses table.

Antibody Details

Note: These compound-specific parameters are only applicable to ADC methods.
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DescriptionParameter

The protein sequence of the antibody.Protein
Sequence

Enzyme to be used to digest the protein.Enzyme

Disulfide bonds are broken when this check box is selected.Break disulfide
bonds

Amino acid in the antibody that the drug molecule can be conjugated to.Site of
conjugation

The chemistry involved in conjugation of the drug molecule to the antibody.Type of
conjugation

Themaximum number of amino acids to be considered as potential fragments,
after digestion.

Max. AA count

Automatically generated by the software. Indicates the number of fragments
that have been selected in the table.

Selected
fragments

Edit the Isotopic Enrichment for Peptide and
Oligonucleotide Formulas
Prerequisite

A custom amino acid, with or without a custom amino acid modification, must be created. Refer
to the sections: Create a Custom Amino Acid and Create a Custom Amino Acid Modification.
The custom amino acid or the custom amino acid modification must contain at least one enriched
isotope.

1. In the Workflow panel, click Processing Parameters.
The processing parameters workspace opens.

2. Click New > Peptides or New > Oligonucleotide

Note: Alternatively, select an entry from the compound library to fill in the sequence.

3. Type theCompound name for the custom amino acid or oligonucleotide in the field provided.

4. Type the Sequence information for the custom amino acid or oligonucleotide. The sequence
must include at least one enriched isotope.

5. Click in the Chemical formula field.
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The Chemical formula field and the m/z value are populated with the information related
to the custom amino acid.

Tip! An icon is shown above the sequence. Hover over the icon with the cursor to view
the Symbol and Residue Formula of the custom amino acid used.

6. Click the Compound-Specific Parameters > Isotope Pattern.
In the Isotopic Enrichment table, the residue formula of the custom amino acid is shown in
the Element column and 100 is shown in the Enrichment % column.

7. Modify the Enrichment % value, as required.

8. Click Save and Close.
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The Batch workspace is used to process multiple sample files at the same time. The batch table
can be completed manually, or an existing batch can be imported to populate the table.

1. To manually prepare a batch, continue with the section: Create a Batch.

2. To open an existing batch, continue with the section: Open a Batch.

3. To import an existing batch, continue with the section: Import a Batch.

About the Batch Workspace
Use the Batch workspace to create batches of sample for processing.

Figure 6-1 Batch Workspace
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DescriptionItem

Menu bar. Contains these buttons:
• Options: Opens the Batch Processing Options dialog where the user can

specify the options that are relevant to the batch. Refer to the section:
Batch Processing Options.

• New: Click to save the batch. Only available after a sample has been
added to the Sample/Controls field.

• Open: Opens the Open Processing Batch dialog where the user can select
an existing batch to open. Refer to the section: Open a Batch.

• Import: Opens the Batch Importer dialog where the user can select an
Excel file to import. Refer to the section: Import a Batch.

• Save: Saves the currently open batch file. Automatically replaces the
existing version. Only available after the batch information has been
modified.

• Save As: Saves the currently open batch file. Users can assign a new
name to the batch file.

1

Find Metabolites button. Starts processing of the batch.2

Sample/Controls column. The Sample button opens the Select Data dialog
where the user can select the sample of interest. The Controls button opens
the Select Data dialog where the user can select the corresponding control
sample. A maximum of five controls can be selected per sample.

3

Folder column. Provides a list of folder locations where the processing
parameters and results are stored.

4

Processing Parameters column. Provides a list of the processing parameters
that can be used to process the sample of interest. Only processing
parameters that are stored in the selected Folder are available for selection.

5
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DescriptionItem

Apply Options column. Selected by default. When selected, applies all of
the Auto Assign and Report options chosen in the Batch Processing Options
dialog to the samples and control samples in the batch. Options include:

• Clear the Apply Options check box to clear all of the selected check
boxes.

• Clear specific sample check boxes.

• Select specific sample check boxes.

Refer to the section: Batch Processing Options.

Note:Auto Assign options are not applicable for the oligonucleotide workflow.

6

Results File column. User-specified name for the Results file.7

Specify Batch Options
Refer to the section: Batch Processing Options.

1. In the Workspace panel, click Batch.
The Batch workspace opens.

2. Click Options.
The Batch Processing Options dialog opens.

3. (Small molecule, peptide, and ADC workflows) On the Auto Assign tab:

• Select the check box for each applicable option.

• Type the appropriate value for each selected option.

4. On the Report tab:

• Select the check box for each applicable option.

• Type the appropriate value for each selected option.

5. Click OK.
The batch options will be saved with the batch.
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Batch Processing Options
DescriptionOption

Auto Assign

Note: The auto assign options are independent of one another. They are considered "or"
conditions. One or more of the selected options must meet the criteria specified.

Note: The auto assign options are not applied to oligonucleotide samples.

Proposes potential structures or sequences for metabolites that
meet the criteria of the selected option. Dependent on the data type
and processing parameters used (that is, whether it is a small
molecule or a peptide).

Note: Multiple options can be selected.

Assign Structures or
Sequences

Proposes potential structures or sequences for metabolites with the
XIC peak area above the specified value.

Metabolites with peak
areas above (%)

Proposes potential structures or sequences for metabolites with the
analog peak area above the specified value.

Metabolites with analog
peak areas above (%)

Proposes potential structures or sequences for metabolites that
have an MS/MS quality above the specified value.

This option is not applicable to oligonucleotide workflows.

Metabolites with MS/MS
quality above

Report

Note: The report options are dependent on one another. They are considered "and" conditions.
All of the selected options must meet the criteria specified.

Shows a check mark in the Report column of the Potential
Metabolites table for any metabolite that has an assigned structure
or sequence.

Report metabolites with
assigned structures or
sequences

Shows a check mark in the Report column of the Potential
Metabolites table for any metabolite that has a peak area above the
specified value.

Report metabolites with
peak areas above (%)

Molecule Profiler SoftwareSoftware User Guide
63 / 166RUO-IDV-05-12707-A

Search for Potential Molecules



DescriptionOption

Shows a check mark in the Report column of the Potential
Metabolites table for any metabolite that has an analog peak area
above the specified value.

Report metabolites with
analog peak areas above
(%)

Shows a check mark in the Report column of the Potential
Metabolites table for any metabolite that has a score above the
specified value.

Report metabolites with
scores above (%)

Create a Batch
Note:Only one sample in each row can be processed. Amaximum of five controls can be selected
for each sample. However, controls are not required for processing.

1. In the Workspace panel, click Batch.
The Batch workspace opens.

Tip! Select the Open option to retrieve a previously saved batch file. Refer to the section:
Open a Batch.

2. Add an MS sample by doing this:

a. In the first available row of the batch table, click Sample.
The Select Data dialog opens.

b. Click Browse and then navigate to the appropriate source folder.
c. Select the wiff file and injection containing the sample of interest in the Available field

and then click >>.
The sample information is shown in the Selected field.

3. (Optional) Add an analog sample by doing this:

Tip! If analog data was acquired, then select the Use analog data check box to
automatically add analog data when adding the MS sample.

a. In the first available row of the batch table, click Use analog data.
b. Open the Analog Sample tab.

c. Click Browse and then navigate to the appropriate source folder.
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d. Select the analog sample in the Available field and then click >>.
The sample information is shown in the Selected field.

4. Click OK.
The Sample/Controls field of the selected row in the batch table is populated with the
sample information.

5. (Optional) Add an MS control by doing this:

a. In the first available row of the batch table, click Control.
The Select Data dialog opens.

b. Click Browse and then navigate to the appropriate source folder.
c. Select the wiff file and injection containing the control in the Available field and then

click >>.
The sample information is shown in the Selected field.

d. Continue with the following step to add an anolog control, or clickOK to close this dialog.

6. (Optional) Add an analog control by doing this:

a. In the first available row of the batch table, click Use analog data.
b. Open the Analog Sample tab.

c. Click Browse and then navigate to the appropriate source folder.
d. Select the analog sample in the Available field and then click >>.

The sample information is shown in the Selected field.

e. Click OK.
The Sample/Controls field of the selected row in the batch table is populated with the
sample information.

7. In the Folder column, select the folder where the processing parameters and Results files
will be saved.

8. In the Processing Parameters column, select a processing parameters file.

Tip! To view the processing parameters file, click P. Change the parameters as required,
and then click Save and Close to save them.

9. In the Results File column, type the name of the file in which the results will be stored.
10. Repeat step 2 to step 9 for each row in the batch.

Note: The maximum number of rows that can be processed in one batch is 200.
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Tip! To facilitate the creation of the batch, rows can be copied and pasted or deleted.
Refer to the sections: Copy and Paste a Batch Row or Clear a Batch Row.

Copy and Paste a Batch Row
Use the copy and paste options to edit a batch.

1. In the batch table, select the row to be copied.

2. Right-click and then select Copy Batch Row.
3. Select the destination row of the pasted information.

4. Right-click and then select Paste Batch Row.

Note: Any existing information in the destination row is overwritten.

Clear a Batch Row
Rows of sample information can be cleared when creating a batch.

1. In the batch table, select the row to be cleared.

2. Right-click and then select Clear Batch Row.
All of the data is removed from the selected row.

Open a Batch
1. In the Workspace panel, click Batch.

The batch workspace opens.

2. Click Open.
The Open Processing Batch dialog opens.

3. Select the batch file and then click OK.
4. Do one of the following:

• If the batch is complete, then continue with the section: Submit a Batch.
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• If the batch is incomplete, then continue with the section: Create a Batch.

Import a Batch
1. In the Workspace panel, click Batch.
2. Click Import.

The Batch Importer dialog opens.

3. Click Browse.
The Open excel file dialog opens.

4. Navigate to and then select the appropriate Excel file.

Note: The Excel file should be created using the example template
(BatchImportTemplate.xlsx) that is distributed with the software. During installation, the
template is installed in the following location: C:\ProgramData\SCIEX\Molecule
Profiler\Batch Import Templates folder.

5. Click Open.
The Target batch file field is populated with the name of the imported Excel file. This
information can be modified, if required.

6. Do one of the following:

• To convert the selected Excel file to a Molecule Profiler software batch and open batch
in the Batch workspace, click Convert and Open and continue with step 7.

• To convert the selected Excel file to a Molecule Profiler software batch that can be opened
in the Batch workspace at a later time, click Convert and continue with step 7.

• To cancel the import, click Close.
7. Do one of the following:

• If the Convert and Open option was selected and all of the processing parameters
(method files) and folders referenced in the Excel file are stored in the correct locations,
then continue with the section: Submit a Batch.

• If the Convert option was selected and all of the processing parameters (method files)
and folders referenced in the Excel file are stored in the correct locations, then continue
with the section: Save a Batch.
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• If the Convert and Open option or Convert option was selected and a confirmation
dialog is shown, then continue with step 8.

Figure 6-2 Confirmation Dialog

8. Do one of the following:

• (Small molecule workflow) To automatically create the required method files, continue
with step 9.

Note: The Method Generator cannot be used with peptide, oligonucleotide, or ADC
workflows.

• To manually create the required method files, click No and then cancel the import.
Continue with the section: Create Processing Methods.

9. Click Yes.

Figure 6-3 Method Generator Dialog

10. Select the appropriate folder from the Source data folder list.
11. Select the appropriate method file from the Parameters to copy list.
12. Click the folder icon to the right of the Compound structure folder field and then browse

to and select the folder that contains the precursor structures of the processing parameters.
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13. Do one of the following:

• Click Sample if the sample wiff file contains the reference MS/MS.
• Click Control if the control wiff file contains the reference MS/MS.

14. Click Create.
The processing parameters and any missing folders are created and stored in the location
specified in the Excel spreadsheet.

15. Do one of the following:

• If the Convert and Open option was selected, then continue with the section: Submit a
Batch.

• If the Convert option was selected, then continue with the section: Save a Batch.

Save a Batch
Information that has been added to the table in the Batch workspace can be saved for later use.

1. To save a batch using the same file name, click Save.
2. To create a batch using a different name, click Save As.

The Save Processing Batch As dialog opens.

3. Type a unique Name and then click OK.

Submit a Batch
After the batch is prepared and the batch options have been specified, the batch is submitted for
data processing.

Note: If required, the processing parameters can be modified for a sample of interest before the
batch is submitted.

1. (Optional) To view the processing parameters for a sample, do this:

a. Select the row containing the sample of interest and then click the P located to the right
of the Processing Parameters field.
The processing parameters associated with the selected sample are shown.

b. Make any necessary modifications and then click Save and Close.
The Batch workspace is shown.

2. Click Save As.
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The Save Processing Batch As dialog opens.

3. Type a unique Name and then click OK.
4. Click Find Metabolites.

Processing of the batch begins. A progress bar shows the status of the processing. During
processing, the P is disabled to prevent modification of the parameters. When the processing
for the row is complete, the P located to the right of the Processing Parameters field and
the R located to the right of the Results File field are available.

5. Click the R to open the Results file in the Results workspace.

Note: Any Auto Assign and Report options that were selected in the Batch Processing
Options dialog are completed by the software.

6. (Optional) Complete step 1 to save the updated the processing parameters.

7. Click Save.

Tip! Click Save As to save the batch with a different name.
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Use the Results workspace to view the results of searching for potential metabolites in a sample
of interest.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

About the Results Workspace
After the software processes the data, use the Results workspace to view the list of potential
metabolites.
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Figure 7-1 Results Workspace
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DescriptionItem

Menu bar. Contains these buttons:
• View

• Processing Parameters: Shows the processing parameters for the
results.

• Batch Options: Shows the batch processing options for the results.
• Sample Details: Shows detailed information about the sample.

• Open: Opens the Open Results dialog where users can browse to the
appropriate Results file.

• Save: Saves the currently open Results file. Automatically replaces the
existing version.

• Save As: Saves the currently open Results file. Users can select the
destination folder and assign a new name to the Results file.

1

Potential Metabolites pane. Lists all of the peaks that were found by the
selected algorithms in the sample of interest. Refer to the section: About Peak
Finding Strategies.
Edit the results by deleting rows that do not contain potential metabolites,
changing the name and formula, adding MS/MS spectra, and assigning peak
IDs. Refer to the section: Edit Results.

For a description of the columns in the Potential Metabolites table, refer to
the section: Table 7-1.

Note: Predefined filters might affect the potential metabolites shown in the
list. Refer to the table: About Results Filters.

2
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DescriptionItem

Details pane. Provides information about how the potential metabolite was
scored. For each property in the processing method, Scoring list shows the
score for the individual metabolite, as well as the total score for all metabolites,
are shown. Refer to the section: Confirmation Scoring Tab. Scores are shown
for Mass Defect (disabled for oligonucleotides), Isotope Pattern, MS/MS,
Mass Accuracy, and Total confirmation score.
For small molecule results, the Structure list shows the available structure.
For ADC results, the Structure list shows both the available structure and
the available sequence.

For peptide results, the Sequence list shows the available sequence.
For oligonucleotide results, the Sequence list shows the oligonucleotide
sequence for the selected metabolite, as determined by the MS/MS
assignment in the Interpretation view. If no assignment was made, then this
field is blank.

3
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DescriptionItem

Chromatograms pane. Enables the user to show different chromatograms for
the potential metabolite that was found:
• Metabolites: Shows the sum of all of the metabolite peaks currently found.

All major chromatographic peaks are shown, with their RTs and peak IDs.
The selected metabolite peak and any peaks eluting at the same retention
time are yellow.

• XIC: Shows an extracted ion chromatogram (XIC) for the selected
metabolite. Isotopes selected for XIC extraction are labeled at the top of
the graph.

• Mass Defect: Shows the mass defect chromatograms used to identify the
selected metabolite. This is specific to small molecules data only.

• Isotope Pattern: Shows a chromatogram of all of the peaks with isotope
patterns that match the parent compound.

• Product Ions: Shows a chromatogram of all of the peaks with fragment
ions that match the selected fragments on the Product Ion and Neutral
Losses tab.

• Neutral Losses: Shows a chromatogram of all of the peaks with neutral
losses that match the selected neutral losses on the Product Ion and
Neutral Losses tab.

• Isotope Pattern (SWATH acquisition data): Shows a chromatogram of all
of the peaks with fragment isotope patterns that match the selected
fragment isotope patterns on the Product Ion and Neutral Losses tab.

• Analog Data: Shows an analog chromatogram of all of the peaks. A peak
label indicates matching peak IDs for both the analog peak and the
corresponding MS peak.

Note: TheMass Defect, Isotope Pattern, Product Ions, Neutral Losses,
and the Isotope Pattern (SWATH acquisition data), chromatograms are
available only if these algorithms were selected for processing. In addition,
if analog data was processed, as defined in the processing method, then
the Analog Data chromatogram is available in the Chromatograms list.

Note: In oligonucleotide workflows, only theMetabolites, XIC, and Analog
Data views are available.

Note: If the Show Controls check box is selected, then both the XIC and
the Analog Data chromatogram, if applicable, show the control traces.

4
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DescriptionItem

MS pane. Shows the MS spectrum. The options in the Show list select the
peaks to be highlighted:
• Default: Shows a portion of the sample MS, centered around them/z value

of the selected metabolite.

• Mass Defect: Highlights all of the m/z values that match any mass defect
filter selected in the processing method. This is specific to small molecules
data only.

• Isotope Pattern: Highlights all of them/z values that have the same isotope
pattern as the parent compound.

For oligonucleotide workflows,Predicted Isotope Pattern andCharge Series
traces are overlaid by default. The default view shows the centroided TOF
MS spectrum for the selected metabolites. The monoisotopic peak is labeled
with the predicted charge, and a blue arrow indicates its position. Red arrows
on the m/z axis indicate individual isotopes that were selected for XIC
extraction and area determination. A theoretical isotopic envelope overlays
centroid peaks to provide a goodness-of-fit assessment for observed data.
To set the spectrum to full range, double-click below the m/z axis. To view
the predicted location of additional charge states for the selected metabolite,
pan and zoom by left-clicking and dragging across the m/z axis.

5

MS/MS pane. Shows an MS/MS spectrum for the selected metabolite. The
source of this data is one of the following:
• The sample IDA wiff file.

• The sample SWATH acquisition wiff file.

• The dedicated MS/MS wiff file that was added to the Results file. Refer to
the section: Add Multiple Spectra with the Add MS/MS Button.

For oligonucleotides, common product ion peaks that were matched to the
reference MS/MS spectrum selected in the processing parameters are yellow.
Unmatched product ions peaks are blue.

6
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Table 7-1 Potential Metabolites Table Columns

DescriptionColumn

When selected, includes the metabolite in the final report.Report

Shows the Peak ID of the metabolite. The ID is based on the retention time
and the mass of the metabolite. For all Parent metabolites, the Peak ID is
blank.

A -# is assigned to peaks with the same mass and retention time but different
a charge. For example: M1-1, M1-2, M1-3, and so on.

Peak ID

Shows the name of the metabolite.

For ADC results, the names are preceded by the word Parent. Parent indicates
that the small molecule drug (payload) and linker components are combined.

For oligonucleotide results, the main component names are indicated by the
words Parent and Ion charge. Biotransformation and cleavage products
identified by the predicted peak finder have the characteristic 5' or 3' (n-#)
notation. Generic peak finder results are indicated by either a Gain or Loss
prefix.

Name

Shows the neutral formula of the metabolite.Formula

When selected, indicates that information exists in the Interpretation
workspace. For example, a structure or sequence might be present or the
Fragments table might be populated.

Assigned

Shows the neutral mass of the metabolite.Neutral Mass

Shows the monoisotopic mass to charge ratio for the metabolite.

For oligonucleotides results, if the monoisotope is not observed, then the
software calculates its position and flags the m/z value with an (n), where n
denotes the number of peaks that the monoisotope is away from the first
observed peak.

m/z

Shows the charge of the metabolite.Charge
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Table 7-1 Potential Metabolites Table Columns (continued)

DescriptionColumn

Reflects the isotope of the XIC peak area shown for the metabolite.

• Blank cell: monoisotope
• 1: the first isotope after the monoisotopic peak
• 2: the second isotope after the monoisotopic peak, and so on
If the column is not included in the table, then the XIC peak area is associated
with the monoisotope of the metabolites. For metabolites identified by the
predicted metabolite finding strategy, an estimated hypothetical base peak
index is shown for a metabolite. For metabolites identified by other peak
finding strategies, the experimental isotopic peak is shown. Usually, the
experimental isotopic peak is the base peak. However, for IDA data, the
experimental isotopic peak could be the index of the precursor ion.

Peak Index

Shows the mass accuracy (in ppm) of the metabolite.ppm

Shows the retention time of the metabolite.R.T. (min)

Shows the XIC peak area of the isotope whose peak index is shown in the
Peak Index column.

Peak Area

Shows the % area of the XIC, based on the total number of metabolites in
the table.

% Area

Shows the % score of the metabolite.% Score

Shows the peak area of the analog peak. Available only when analog data
has been processed.

Analog - Peak
Area

Shows the % area of the analog peak. Available only when analog data has
been processed.

Analog - % Area

Shows the retention time of the analog peak. Available only when analog data
has been processed.

Analog - R.T.
(min)

Show Filtered Spectrum Only

Note: This feature is not applicable for oligonucleotide workflows.

If the Use advanced MS/MS filter parameter was selected to process a SWATH acquisition data
file on the MS/MS Parameters tab in the Generic Parameters group in the Processing Parameters
workspace, then select this check box to show only an MS/MS spectrum filtered with the advanced
filter. Clear the check box to show the background-subtracted spectrum.
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Note: If the Use advanced MS/MS filter parameter was selected but only the
background-subtracted spectrum is shown in the MS/MS spectrum, then this might be a result
of:

• Blank filtered spectrum.

• Ineffective advanced filter caused by interference from a co-eluting peak that was approximately
10-fold or higher in intensity.

• Ineffective advanced filter caused by less than five data points across the precursor peak.

About Results Filters
Filters can be applied to refine the results shown in the Potential Metabolites table.

Tip! Click the filter icon to open the Results Filters dialog.

Table 7-2 Filters

To show thisSelect this filter

Metabolites

Only the specified number of peaks that are the most abundant based
on % peak area.

Top __ metabolites by
peak area

Only the metabolites that have been selected in the Report column.Reported metabolites

Only the metabolites that were found by a primary adduct. A primary
adduct is defined as the adduct which is the first visible selection in
the Advanced Ion Types table of the Generic Parameters > MS
Parameters tab. Options include:
• Primary

• Most intense

Metabolites by adduct

Assigned Metabolites

Only the metabolites that have assigned structures (small molecules)
or assigned sequences (peptides and oligonucleotides), as indicated
by a check mark in theAssigned column in the Potential Metabolites
table.

Metabolites with
structures or sequences
assigned

Retention Time Window
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Table 7-2 Filters (continued)

To show thisSelect this filter

Only peaks within the specified range.Retention time from __ to
__

Peak Area

Only peaks with a % Area that is within the specified percentage
range.

Peak area from __ % to
__ %

Only peaks with a % Analog Area that is within the specified
percentage range. If no analog files were provided for processing,
then this filter has no effect.

Analog peak area from
__ % to __ %

Charge

Only the metabolites with a charge value that are within the specified
range.

Charge from __ to __

Score

Only peaks with an overall score that is above the specified value.
Refer to the section: Confirmation Scoring Tab.

For oligonucleotide workflows, we recommend that the isotope
envelope be used as the sole parameter in confirmation scoring. We
also recommend that the user set Overall Score above 20% to
remove metabolites with low theoretical isotope overlap scores.

Overall score above __
%

Mass Accuracy

Only peaks with a mass accuracy that is within the specified range.Accuracy within __ ppm

Mass Range

Only m/z values that are within the range specified.m/z from __ to __

Product Ions and Neutral Losses

Only peaks with an MS/MS similarity score that is above the specified
value. If a reference spectrum was not provided, then this filter has
no effect.

MS/MS similarity above
__

Only peaks that have at least the specified number of product ions
in common with the parent compound. If a reference spectrum was
not provided, then this filter has no effect.

Minimum number of
common product ions __

Only peaks that have at least the specified number of neutral losses
in common with the parent compound. If a reference spectrum was
not provided, then this filter has no effect.

Minimum number of
common neutral losses
__
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Note: Deleting and adding rows to the table will automatically update the%Area and%Analog
Area of each metabolite, affecting how the peak area, analog peak area, and top metabolites by
peak area filters are applied to the remaining rows.

Edit Results
Entries in the Potential Metabolites table can be edited or deleted to further refine the results.

Users can:

• Delete Rows

• Edit the Name and Formula of a Potential Metabolite

• Assign Peak IDs

Delete Rows

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Select a row in the Potential Metabolites table.

Tip! Click and press Ctrl or Shift to select multiple rows.

6. Click Edit > Delete Selected Rows.

Tip! To revert the most recent deletion, click Edit > Undo Delete.

7. Click Save.

Edit the Name and Formula of a Potential Metabolite
Refer to the section: How metabolites are named by the software.
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1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Right-click a row in the Potential Metabolites table and select Edit Name and Formula.
The Edit Name and Formula dialog opens.

6. Do one of the following to change the Name:
• If applicable, select a name from the list of options provided.

• Type a new name.

7. If applicable, select an adduct from the list of options provided.

Note: If the adduct is changed, then theMass accuracy of the metabolite is automatically
updated.

8. Do one of the following to change the Formula:
• If there is insufficent information available to determine a formula, then selectUnknown.
• To manually add a formula to the potential metabolite, selectUse and then type a formula

in the field provided.

• If potential formulas were predicted by the software, then select Automatic and select
an entry from the list.

Note: If potential formulas were not predicted by the software, then Automatic is not
available for selection.

Note: The values in theMass accuracy and RDB fields are automatically updated by the
software when the new formula is added.

9. To identify the metabolite from the selected row as the parent compound, click Assign as
Parent.

10. Click OK.
11. Click Save.
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Note: For peptides, the order of the names is based on the mass accuracy of the proposed
name and the number of manipulations required, for example, the number of bonds broken.
That is, the proposed name for the peptide with a higher mass accuracy and fewer
manipulations is shown at the top of the list.

Group by Peaks
Use the Group by Peaks button to group peaks that have the same neutral mass, such as the
multiple charge states of a molecule, to show a summary table of the identified molecules, with
Peak Area, %Area, and so on, totalled for all identified charge states. The peaks are grouped
based on neutral mass and retention time tolerance.

Note: The group function is applicable to the oligonucleotide workflow only.

Assign Peak IDs

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Review the current peak IDs in the Potential Metabolites table.

6. Make any changes to the table, including deleting rows and renaming metabolites.

7. Click Assign ID.
Rows related to the same neutral formula and retention time are grouped together. One
row is assigned the primary peak ID and the remaining rows in the group are assigned a
sequential ID, one level below the primary peak ID. For example, if the assigned primary
peak ID is M2, each remaining row is assigned a sequential ID beginning with M2. For
example, M2-1, M2-2, and so on.

Non-primary peak IDs are assigned to peaks with non-primary adducts. Non-primary adducts
are those which have been selected in the Advanced Ion Types table but are not shown in
the Ion type list. Only the primary peak IDs are shown in the Ion type list.
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MS/MS Spectra
MS/MS spectra can be added, removed, or replaced for any metabolite. An MS/MS spectrum can
be added manually by copying a single centroided MS/MS spectrum in the Explorer workspace,
and then pasting it in the Results workspace, or automatically with the Add MS/MS button in the
Results workspace.

Add Spectra by Pasting

Note: This is a beta feature.

Note: This feature is available only in the oligonucleotide workflow, for TOF-MS/MS and IDA
data. Pasting MS/MS spectra from the IDA Explorer is currently not supported. Data files must
be opened as a standard TIC and centroided in the Explorer workspace before being pasted into
Molecule Profiler.

Note: The existing MS/MS spectrum in the Results file is not overwritten until the Results file is
saved. To revert to the original spectrum for the selected metabolite, as stored in the Results
file, click Remove MS/MS before saving the Results file.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and select the appropriate file, and then click OK.
The Results view is shown.

4. Select a row in the Potential Metabolites table.

5. From the SCIEX OS Home page, open the Explorer workspace.

6. Select File > Open Sample.
The Select Sample dialog opens.

7. Browse to the data file that contains the sample, click + to expand it, select the sample to
be opened, and then click OK.
The data file must be a wiff or wiff2 data file that contains TOF-MS/MS or IDA data.

8. If the data file contains IDA data, select As a standard TIC in the Open IDA Sample dialog,
and then click OK.

9. Open an MS and MS/MS spectrum.
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Tip! To open the spectra, set a selection window, or double-click a retention time in the
TIC pane.

10. Right-click the header of the MS/MS spectrum, and then selectRemove All Traces Except
Active.

11. Select Process > Centroid Spectrum.

The Centroid dialog opens.

12. Select whether to centroid on Intensity, Height, Area, or Intensity sum above 50%.

13. Select Edit > Copy.
14. Go to the Molecule Profiler workspace.

15. Click Paste MS/MS.
The MS/MS spectrum is added.

16. Click Save.

Add Multiple Spectra with the Add MS/MS Button

Note: The existing MS/MS spectrum in the Results file is not overwritten until the Results file is
saved. To revert to the original spectrum for the selected metabolite, as stored in the Results
file, click Remove MS/MS before saving the Results file.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file, and then click OK.
The Results view is shown.

4. Select a row in the Potential Metabolites table.

5. Click Add MS/MS.
The Add MS/MS dialog opens.

6. Click Select MS/MS.
The Select Data dialog opens.

7. Browse to and select the appropriate Source folder.
8. Click OK.
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9. In the Available pane of the Select Data dialog, select the wiff file and injection containing
an MS/MS spectrum and then click the icon ( ) to move the file to the Selected pane.

Tip! Up to 10 injections can be selected.

10. When all of the required files are shown on the Add MS/MS dialog, click OK.
The software tries to find a matching spectrum for each metabolite.

11. Review the score of each metabolite.

If the MS/MS spectrum was changed, then the software might recalculate the % Score.
12. Click Save.

To edit specific fragment types within a single MS/MS spectrum, refer to the section:
Oligonucleotide Workflows.

Remove Spectra

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Select a row in the Potential Metabolites table.

6. Click Remove MS/MS in the MS/MS pane.

Note: If an IDA spectrum exists for the potential metabolite, then it is shown in the MS/MS
pane.

7. Click Save.

Remove MS/MS Spectra Files

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.
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3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Click Add MS/MS.
6. Select the appropriate wiff file in the MS/MS Samples field.
7. Click Remove and then click OK.

All dedicated MS/MS spectra in the wiff file are removed from the results.

8. Click Save.
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After identifying the peaks in a sample of interest, use fragment interpretation to help identify the
structure of each potential metabolite.

About the Interpretation View
The Interpretation view in the Results workspace shows the data and tools required to help elucidate
a potential structure for each metabolite in a Results file.

Interpretation Views

ADC Interpretation
View

Oligonucleotides
Interpretation View

Peptides Interpretation
View

Small Molecule
Interpretation View

Small Molecule Interpretation View

Figure 8-1 Small Molecule Interpretation View
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DescriptionInterface
Component

Item

Shows the MS/MS spectrum of the selected metabolite.
The mirror image of the reference MS/MS spectrum is
also shown, if available. Asterisks identify peaks that have
been selected for assignment. The source of this spectrum
is the sample IDA wiff file, the sample SWATH acquisition
wiff file, or a dedicated MS/MS wiff file that was added to
the Results file. For a description of the functionality
provided by the buttons, refer to the table: Table 8-1.

MS/MS pane1

Lists all of the assigned fragments for the selected
metabolite including their m/z value, the number of
proposed structures, and the score. If a particular m/z
value could be assigned different formulas, the table
contains a row for each formula. By default, the row
containing the highest score for each combination of
formula and m/z value has the Use check box selected.

Tip! Rows that do not have the Use check box selected
can be hidden. To show all rows, right-click the table and
then click Show Hidden Rows.

For a description of the functionality provided by the icons,
refer to the table: Table 8-3.

Fragments table2

Lists the portions of the structure that could yield the
selected fragment including the number of broken bonds,
the delta H value, and the score. Selecting a row in this
table highlights the related portion of the structure.

By default, the fragment structure with the highest score
has the Use check box selected.

Structure Details
table

2a

Contains the neutral losses from the two fragment masses.Contained Neutral
Losses table

2b
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DescriptionInterface
Component

Item

Contains the following two tabs:

• The Parent Structure tab, which contains the parent
structure of the selected metabolite.

• The Structure Candidates tab, which is an interactive
histogram that contains a table showing the complete
list of proposed structures, sorted in descending score
order. Selecting a row in this table changes the
structure shown in the Structure pane (item 2). To
include a specific structure in the results, click the
Apply to Results check box for that structure. Refer
to the section: About the Structure Candidates Tab.

Structure charts
pane

3

Enables the user to load a candidate structure for potential
metabolites and provides basic drawing tools that enable
users to edit the structure. For a description of the
functionality provided by the buttons, refer to the table:
Table 8-2.

Structure pane4

Table 8-1 MS/MS Pane Buttons

DescriptionButton

Hides all of the isotopes in the MS/MS pane. Click again to show the
isotopes.

Deisotope

Opens the Interpret Data dialog where users can edit the details needed
to interpret the selected metabolite (formula, active peaks, MS/MS
spectrum recalibration).

Prepare

Opens the Options dialog where users can assign MS/MS fragments.
Refer to the table: Table 8-15 in the section: Set Options.

Options

Populates the Structure Candidate tab with automatically generated
potential candidates for the selected metabolite. Refer to the section:
About the Structure Candidates Tab.

Generate

Applies the interpretation changes to the selected peak.Apply

Removes the assigned fragments and the metabolite structure from the
selected peak.

Remove
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Table 8-2 Structure Pane Buttons

DescriptionButton

• Load Parent: Opens the parent structure of the selected metabolite.

• Load Structure: Opens a structure file for the selected peak.

Load

Removes the visible structure from the Structure pane.Delete

Enables the user to save the visible structure with a different file name.Save As

Calculates the fragments and neutral losses for the potential structure
and then assigns the ions to the MS/MS spectra.

Assign

Table 8-3 Fragments Table Icons

DescriptionIcon

Adds a label for the selected fragment.

Deletes all of the labels from the MS/MS spectrum.

Opens the Interpretation Filters dialog. Refer to the section: About
Interpretation Filters for Small Molecules.

Peptides Interpretation View

Figure 8-2 Peptides Interpretation View
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DescriptionInterface
Component

Item

Shows the MS/MS spectrum of the selected metabolite.
The mirror image of the reference MS/MS spectrum is
also shown, if available. The source of this spectrum is
the sample IDA wiff file, the sample SWATH acquisition
wiff file, or a dedicated MS/MS wiff file that was added to
the Results file. For a description of the functionality
provided by the buttons, refer to the table: Table 8-4.

MS/MS pane1

Enables the user to input a sequence. For a description
of the functionality provided by the buttons, refer to the
table: Table 8-5.

Sequence pane2

Contains a list of proposed formulas for the selected
potential metabolites. The list includes the m/z values,
sequences, fragment ion types (for example, y or b),
charge, errors, and intensities. For a description of the
functionality provided by the icons, refer to the table: Table
8-6.

Fragments table3

Contains the following two tabs:

• The Parent Sequence tab, which contains the sequence
of the parent drug.

• The Sequence Candidates tab, which is an interactive
histogram that contains a table showing a list of
sequences that are being proposed by the software. A
score, based on the percentage peak area assigned,
is assigned to each proposed sequence. To apply a
specific sequence to the results, select the Apply to
Results check box for that sequence. The applied
sequence shows as the default sequence after the
Results file is closed and then opened again. Refer to
the section: About the Sequence Candidates Tab.

Sequence charts
pane

4

Table 8-4 MS/MS Pane Buttons

DescriptionButton

Removes all of the isotopes from the MS/MS spectrum.Deisotope

Opens the Options dialog. Refer to the table: Table 8-16 in the section:
Set Options.

Options
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Table 8-4 MS/MS Pane Buttons (continued)

DescriptionButton

Populates the Structure Candidate tab with automatically generated
potential candidates for the selected metabolite. Refer to the section:
About the Structure Candidates Tab.

Generate

Applies the interpretation changes to the selected peak.Apply

Removes the assigned fragments and metabolite structure from the
selected peak.

Remove

Table 8-5 Sequence Pane Buttons

DescriptionButton

Enables the user to type a new sequence in the Sequence pane. Refer
to the section: Peptide Sequence Naming Conventions.

Enter Sequence

Opens the parent sequence of the selected metabolite.Load Parent

Removes the visible sequence from the Sequence pane.Delete

Calculates the fragments and neutral losses for the potential structure
and then assigns the ions to the MS/MS spectra.

Assign

Table 8-6 Fragments Table Icons

DescriptionIcon

Adds labels for all of the peaks.

Adds a label for the selected fragment.

Deletes all labels from the MS/MS spectrum.

Opens the Interpretation Filters dialog. Refer to the section: About
Interpretation Filters for Peptides.
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Oligonucleotides Interpretation View

Figure 8-3 Oligonucleotide Interpretation View

DescriptionInterface
Component

Item

Shows the MS/MS spectrum of the selected metabolite.
The mirror image of the reference MS/MS spectrum is
also shown, if available. The source of this spectrum is
the sample IDA wiff file, the sample SWATH acquisition
wiff file, or a dedicated MS/MS wiff file that was added to
the Results file. For a description of the functionality
provided by the buttons, refer to the table: Table 8-7.

MS/MS pane1

Contains a list of proposed formulas for the selected
potential metabolites. The list includes the m/z values,
sequences, fragment ion types (for example, y or b),
charge, errors, and intensities. For a description of the
functionality provided by the icons, refer to the table: Table
8-6.

Fragments table2

Contains the sequence of the parent drug.Sequence charts
pane

3

Enables the user to input a sequence. For a description
of the functionality provided by the buttons, refer to the
table: Table 8-5.

Sequence pane4
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Table 8-7 MS/MS Pane Buttons

DescriptionButton

Removes all of the isotopes from the MS/MS spectrum.Deisotope

Opens the Options dialog. Refer to the table: Table 8-18 in the section:
Set Options.

Options

Applies the interpretation changes to the selected peak.Apply

Removes the assigned fragments and metabolite structure from the
selected peak.

Remove

Table 8-8 Sequence Pane Buttons

DescriptionButton

Opens the parent sequence of the selected metabolite.Load Parent

Removes the visible sequence from the Sequence pane.Delete

Calculates the fragments and neutral losses for the potential structure
and then assigns the ions to the MS/MS spectra.

Assign

Table 8-9 Fragments Table Icons

DescriptionIcon

Adds labels for all of the peaks.

Adds a label for the selected fragment.

Deletes all labels from the MS/MS spectrum.

Opens the Interpretation Filters dialog. Refer to the section: About
Interpretation Filters for Oligonucleotides.
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ADC Interpretation View

Figure 8-4 ADC Interpretation View
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DescriptionInterface
Component

Item

Shows the MS/MS spectrum of the selected metabolite.
The mirror image of the reference MS/MS spectrum is
also shown, if available. The source of this spectrum is
the sample IDA wiff file, the sample SWATH acquisition
wiff file, or a dedicated MS/MS wiff file that was added to
the Results file. For a description of the functionality
provided by the buttons, refer to the table: Table 8-10.

MS/MS pane1

Contains the following tabs:

• The Structure tab, which lists all of the assigned
fragments for the selected metabolite including their
m/z value, the number of proposed structures, and the
score. If a particular m/z value could be assigned
different formulas, then the table contains a row for
each formula. By default, the row containing the highest
score for each combination of formulas and m/z value
has the Use check box selected.

• The Sequence tab, which lists all of the proposed
formulas for the selected potential metabolites. The list
includes them/z values, sequences, fragment ion types
(for example, y or b), charge, errors, and intensities.

For a description of the functionality provided by the icons,
refer to the table: Table 8-13.

Fragments table2

Shows the part of the sequence that is conjugated to the
payload or linker moiety. To indicate the residue that is
conjugated to the payload or linker moiety, select the
residue, right-click, and then select Mark Residue to
Conjugate.

Sequence pane3

Enables the user to load a candidate structure for potential
metabolites and provides basic drawing tools that allow
users to edit the structure. For a description of the
functionality provided by the buttons, refer to the table:
Table 8-11.

Structure pane4
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Table 8-10 MS/MS Pane Buttons

DescriptionButton

Removes all of the isotopes from the MS/MS spectrum.Deisotope

Opens the Options dialog. Refer to the table: Table 8-21 in the section:
Set Options.

Options

Applies the interpretation changes to the selected peak.Apply

Removes the assigned fragments and metabolite structure from the
selected peak.

Remove

Table 8-11 Structure Pane Buttons

DescriptionButton

• Load Parent Structure: Opens the parent structure of the selected
metabolite.

• Load Sequence: Opens the sequence of the selected metabolite.

Load

Removes the loaded structure from the Structure pane, the loaded
sequence information from the Sequence pane, and the assigned
structure and sequence information from the Fragments table.

Delete

Enables the user to save the structure with a different file name.Save Structure As

Calculates the fragments and neutral losses for the potential structure
and then assigns the ions to the MS/MS spectra.

Assign

Table 8-12 Fragments Table Buttons

DescriptionButton

Lists all of the assigned fragments for the selected metabolite including
their m/z value, the number of proposed structures, and the score. If a
particularm/z value could be assigned different formulas, then the table
contains a row for each formula. By default, the row containing the highest
score for each combination of formulas andm/z value has theUse check
box selected.

Structure

Lists all of the proposed formulas for the selected potential metabolites.
The list includes the m/z values, sequences, fragment ion types (for
example, y or b), charge, errors, and intensities.

Sequence
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Table 8-13 Fragments Table Icons

DescriptionIcon

Adds labels for all of the peaks.

Adds a label for the selected fragment.

Deletes all labels from the MS/MS spectrum.

Open the Interpretation Filters dialog. Refer to the section: About
Interpretation Filters for ADC.

Manual Interpretation
Manual Interpretation

ADC WorkflowOligonucleotide
Workflows

Peptide WorkflowsSmall Molecule
Workflow

Small Molecule Workflow
Load a Structure

Edit a Structure

Edit the Name and Formula of a Potential
Metabolite

Prepare for Structural Assignment

Recalibrate the MS/MS Spectrum

Deisotope the MS/MS Spectrum

Select Active Peaks

Select Fragment Peaks for Assignment

Set Options

Assign Proposed Formulae and StructuresAssign Fragment Structures

Select a Formula Structure for Each
Fragment

Attach Markush Structures
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Add a Peak Label to the MS/MS SpectrumAbout Peak Labels

About Interpretation Filters for Small
Molecules

Load a Structure

Before starting structural elucidation of a metabolite, load the structure files that enable the software
to determine potential fragment structures.

Note: If a structure is not loaded, then potential formulas can still be assigned to fragments.

1. In the Workspace panel, click Results.
2. Click Open.

The Open Results dialog opens.

3. Browse to and then select a Results file.

4. Click OK.
5. In the Show field, select Interpretation.
6. Select a row in the Potential Metabolites table.

7. In the Structure pane, click Load and then select the Load Structure option.
The Open Structure File dialog opens.

8. Browse to and then select a structure file.

Note: The software accepts structure files in either sdf or mol format.

9. If minor changes are needed, then edit the structure. Refer to the section: Edit a Structure.

Edit a Structure

After loading a structure for a specific metabolite, use the editing tools to make minor changes.

Tip! Use the editing tools to make minor changes to a structure, such as different attachment
positions for a metabolic transformation. The editing tools should not be used to create new
structures or make major changes to existing structures.
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Table 8-14 Edit a Structure

Do thisTo do this

Drag a specific symbol on the palette to the new position.
The added atom forms a single bond with the closest
existing atom.

Add an atom to a structure

Click a blank square, type the symbol in the Specify
Symbol dialog, and then click OK.

Tip! Click the added square and type a new symbol to
create different atoms.

Create new atoms on the palette

Drag a circle around the required atoms and bonds.Highlight a portion of the structure

Drag a highlighted portion of the structure to the new
position. If the portion is bonded to one other atom, then
the bond moves to the new position. If the portion is
bonded to two or more atoms, then the portion moves but
the existing bonds remain the same.

Move one or more atoms

Right-click the structure and click one of the following:

• Insert .mol File to add another structure.
• Insert Conjugate to add a specific conjugate structure.

Insert a structure into an existing
structure

Right-click a highlighted portion of the structure and then
click Remove Selected Atoms.

Delete one or more atoms

Select two non-bonded atoms, right-click the selection,
click New Bond, and then select the type of bond.

Create a bond

Right-click a bond, click Set Bond Type, and then select
the type of bond.

Edit a bond

Right-click a bond and then click Remove Bond.Delete a bond

Right-click the atom, click Atom Charge State, and then
select the state.

Change the charge state of an existing
atom

Tip! To save the edited structure as a separate file, click Save As.

Tip! Structures can be saved as either mol or sdf files. Type the appropriate extension in the
Save As dialog.
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Prepare for Structural Assignment

There are four tasks that can be completed when a user is preparing for structural assignment:

• Edit the name or formula of the potential metabolite.

• Recalibrate the MS/MS spectrum.

• Select specific peaks in the MS/MS spectrum.

• Select fragment peaks for interpretation.

Note: If none of these tasks are required, then users can disregard these procedures and
immediately assign fragment structures.

Edit the Name and Formula of a Potential Metabolite

Refer to the section: How metabolites are named by the software.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. Right-click a row in the Potential Metabolites table and select Edit Name and Formula.
The Edit Name and Formula dialog opens.

6. Do one of the following to change the Name:
• If applicable, select a name from the list of options provided.

• Type a new name.

7. If applicable, select an adduct from the list of options provided.

Note: If the adduct is changed, then theMass accuracy of the metabolite is automatically
updated.

8. Do one of the following to change the Formula:

• If there is insufficent information available to determine a formula, then selectUnknown.
• To manually add a formula to the potential metabolite, selectUse and then type a formula

in the field provided.
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• If potential formulas were predicted by the software, then select Automatic and select
an entry from the list.

Note: If potential formulas were not predicted by the software, then Automatic is not
available for selection.

Note: The values in theMass accuracy and RDB fields are automatically updated by the
software when the new formula is added.

9. To identify the metabolite from the selected row as the parent compound, click Assign as
Parent.

10. Click OK.
11. Click Save.

Note: For peptides, the order of the names is based on the mass accuracy of the proposed
name and the number of manipulations required, for example, the number of bonds broken.
That is, the proposed name for the peptide with a higher mass accuracy and fewer
manipulations is shown at the top of the list.

Recalibrate the MS/MS Spectrum

1. In the Interpretation view, click Prepare.
The Interpret Data dialog opens.

2. Click the MS/MS Details tab.

3. Select a fragment to use as a calibration point.

4. Right-click the selected fragment and then click Set calibration points.
The color of the fragment circle changes to blue.

5. Repeat steps 3 and 4 to select additional calibration points.

6. To remove set calibration points, select the appropriate calibration points, right-click, and
then select Clear calibration points.
The color of the fragment circle reverts to green.

7. To view the details of a fragment, select a calibration point, right-click, and then select
Composition details.
The Fragment dialog opens, providing them/z value, the mass error in both ppm and mDa,
an indication of whether or not the proposed formula points to an even electron, and the
RDB value (rings and double bonds) of the proposed formula.
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8. To select a calibration point as the composition of the fragment or as a potential calibration
point, select a calibration point, right-click, and then select Select composition.

9. Right-click the MS/MS spectrum and then click Recalibrate.

Note: To discard the recalibrated spectrum, right-click the spectrum and then click Revert
Calibration.

Deisotope the MS/MS Spectrum

In the Interpretation view, when Deisotope is clicked, all of the isotopes are removed from the
MS/MS spectrum. This provides a quick view of the monoisotopic peaks, which is useful when
viewing SWATH acquisition data.

Note: Only the monoisotopes are shown in the Results Table regardless of whether or not this
option is selected.

Select Active Peaks

Active peaks are the only peaks in the MS/MS spectrum that are available for fragment
interpretation.

1. In the Interpretation view, click Prepare.
The Interpret Data dialog opens.

2. Review the MS/MS spectrum.

Blue arrows identify the current active peaks.

3. To select a peak, drag a square across the peak.

4. Double-click the selected peak.

A blue arrow is shown below the selected peak.

5. To remove single peaks, drag the blue arrow below the border of the Interpret Data dialog.

The blue arrow is removed from below the selected peak.

Tip! To clear all active peaks, right-click the spectrum and then click Clear All Markers.

6. After selecting all active peaks, click Find.
7. Select the row with the formula that best matches the MS and MS/MS spectra.

8. Click Select.
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Select Fragment Peaks for Assignment

Although several peaks might be identified as active, users can select to work with only those
peaks that have the highest intensities.

1. In the Interpretation view, click Options.
The Options dialog opens.

2. In the Number of fragment peaks selected for assignment field, type the appropriate
number.

3. Click OK.
Asterisks in the MS/MS spectrum identify the peaks selected for assignment.

Set Options

1. In the Interpretation view, click Options.
The Options dialog opens.

2. Modify the fragmentation and labeling parameters as described in the table: Table 8-15.

Table 8-15 Options Dialog

DescriptionOption

Use this field to specify the number of fragment peaks that will be
assigned. This number can be a subset of the total number of peaks
that have been selected in the Prepare dialog. If it is a subset of
the total number of peaks, then peaks are chosen in order of
intensity.

Number of fragment
peaks selected for
assignment

Use this field to specify the threshold used to assign fragment peaks.
Peaks below this threshold will not be assigned. Noise is defined
as the peak with the smallest intensity in the MS/MS spectrum.

Minimum
signal-to-noise ratio

For a fragment peak to be assigned a formula and potentially a
structure, its mass accuracy must fall within the MS/MS m/z
tolerance specified.

MS/MS m/z
tolerance (ppm or
mDa)

Fragmentation Settings

Select this check box to break the aromatic ring.Break aromatic
rings
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Table 8-15 Options Dialog (continued)

DescriptionOption

Use this field to specify the maximum number of bonds to break.
Options include:

• 1
• 2
• 3
• 4

Maximum number
of bonds to break

Use this field to specify themaximum number of C-C bonds to break.
Options include:

• 0
• 1
• 2
• 3
• 4

Maximum number
of C-C bonds to
break

Label Settings

Use this field to specify the information that should be shown in the
peak labels. Options include:

• Ion
• Ion with ppm Error
• Ion with mDa Error

Label peaks with

Select this check box to apply the current options to all unassigned
metabolites.

Apply options to all
potential
metabolites

Assign Fragment Structures

To assign structures, the software links the fragment peaks in the MS/MS spectrum to potential
portions of the candidate structure. Users can then select a formula and structure that best matches
the m/z value of each fragment. After assignment takes place, the asterisks that identified peaks
selected for assignment are replaced with either a check mark to show that assignment took place
or an x to show that no assignment was possible.
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Note: The fragmentation rules are embedded in the software and cannot be edited.

Assign Proposed Formulae and Structures

Each metabolite must have an MS/MS spectrum before fragment structures can be assigned. To
add a spectrum, refer to the section: Add Multiple Spectra with the Add MS/MS Button.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. In the Show field, select Interpretation.
6. Load and edit a candidate structure. Refer to the sections: Load a Structure and Edit a

Structure.

7. If required, prepare for structural assignment. Refer to the section: Prepare for Structural
Assignment.

8. In the Structure pane of the Interpretation view, click Assign.
Three tables are shown below the MS/MS pane: the Fragments table, showing the identified
fragments, the Structure Details table, showing potential structures, and the Contained
Neutral Losses table, showing the contained neutral losses.

Note: If a structure is not loaded, then the software assigns only potential formulas to
fragments.

Select a Formula Structure for Each Fragment

1. If appropriate, in the Interpretation view, right-click each of the Fragments, Structure Details,
and Contained Neutral Losses tables and then click Show Hidden Rows.

Note: In the Fragments table, the row containing the highest score for the m/z value has
the Use check box selected. In the Structure Details table, the row with the highest score
has the Use check box selected. In the Contained Neutral Losses table, all rows have the
Use check box selected.
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2. In the Fragments table, select the Use check box to identify the row that contains the most
accurate formula for each m/z value.

Tip! In the Fragments table, select the Use check box in more than one row to select
multiple potential formulas for each fragment.

3. In the Structure Details table, select theUse check box to identify the portions of the structure
that most accurately match the selected formula.

4. In the Contained Neutral Losses table, select the Use check box to identify the row that
most accurately reflects the contained neutral losses.

Tip! In the Structure Details and Contained Neutral Losses tables, select the Use check
box in more than one row for a particular fragment.

5. Click Apply.
The interpretation data is saved for the selected metabolite.

6. When all changes are made, click Save.

Tip! To delete all interpretation data for a specific metabolite, click Remove.

About the Structure Candidates Tab

When automatic structure generation is used, the Structure Candidates tab in the Structure charts
pane is populated with a list of structures for the selected metabolite that satisfy the conditions set
in the Options dialog. Refer to the section: Batch Processing Options. The software generates
structures for the following types of metabolites:

• Metabolites with one or two cleavages

• Single biotransformation metabolites

• Metabolites with one cleavage and single biotransformation

In the case of more complex metabolism, the user can provide or edit a custommetabolite structure
and assess such structure proposal.

The list of structures (referred to as the histogram) contains the following columns of information:
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DescriptionColumn

Indicates the position or ranking of the structures.Rank

The ranking or scoring is based on a comparison between the MS/MS
spectrum of the parent structure and the MS/MS spectrum of the metabolites.
Metabolite fragments are then compared against those of the parent to identify
shifted and non-shifted fragments. Other attributes, such as the fragment
intensity and the uniqueness of a proposal, are also considered in the overall
ranking strategy. The final ranking indicates the probability that a
biotransformation or a cleavage will take place at a particular atom index.

This column also enables the user to toggle between structures. Refer to the
section: Toggle between Structures.

Relative
Evidence

A selected check box indicates that the corresponding structure will be saved
for the Results file.

Apply to Results

The total number of candidates is shown above the histogram table, directly above the Apply to
Results column.
Auto-generated structures cannot be edited. Users can load a structure, make any necessary
modifications, and then select the Apply to Results check box to include the structure in the
Results file. Refer to steps 7 and 8 of the sections: Load a Structure and Edit a Structure.

Toggle between Structures

• Click a blue bar in the histogram.

The corresponding structure is shown in the Structure pane.

Select an Empty Pane

• Click the first line in the histogram.

The first line in the histogram contains the words No structure. The Structure pane refreshes,
with the phrase No structure shown.

Add a Structure

Note: Only one structure can be added to the list of auto-generated structures. If an additional
structure is added, then the previous user-added structure is overwritten.

1. In the Structure pane, click Load and then select the Load Structure option.
The Open Structure File dialog opens.

2. Browse to and then select a mol or sdf file.
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3. Click Open.
The selected structure is shown in the Structure pane and a line is added to the histogram
table, immediately above the first auto-generated structure. The shade of blue for the loaded
structure row is slightly different than the blue for the lines containing the auto-generated
structures. The ranking is set a 0.

The user-added structure can be edited. Any changes made to the structure will be held in
memory when the user tabs out of the Structure pane.

Select a Structure to View

1. Click a blue bar in the histogram.

The corresponding structure is shown in the Structure pane. By default only the first structure
in the histogram has the Fragments table assigned.

2. To assign the Fragments table for a different structure, click the blue bar in the histogram
and then click Assign.

Delete a Structure

1. Click a blue bar in the histogram.

The corresponding structure is shown in the Structure pane.

2. In the Structure pane, click Delete.
The structure is removed from the Structure pane, the selected blue line is removed from
the histogram, and the Fragments table is removed. The structure of the next line in the
histogram is shown in the Structure pane.

Attach Markush Structures

After assigning fragment structures, use Markush structures to show approximate positions for
chemical modifications.

Note: Fragment structures cannot be assigned to a metabolite that contains a Markush structure.

1. Highlight a portion of the structure.

2. Right-click above or below the structure and then click Attach Markush.
3. Select either Single Bond or Double Bond.
4. In the Select Symbol dialog, type the required symbol or formula.

5. Click OK.
The Markush structure is shown with a dashed line connecting it to the selected portion of
the structure.
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Note: Changes to the structure can be made after assigning interpretation data, if a
Markush structure is attached. If the Markush structure is removed, then any changes will
delete all interpretation data for the metabolite.

About Peak Labels

A peak can be labeled with:

• an ion formula or ion type (for a peptide)

• an ion formula or ion type (for a peptide) and ppm error

• an ion formula or ion type (for a peptide) and mDa error

Add a Peak Label to the MS/MS Spectrum

1. In the Interpretation view, click Options.
The Options dialog opens.

2. In the Label peaks with field, select the label type.

3. Click OK.
4. In the Fragments table, select the row containing the peak to be labeled.

5. Click .

Tip! To remove all labels from the MS/MS spectrum, click .

About Interpretation Filters for Small Molecules

Apply filters to refine the data shown in the Fragments table. To access the Interpretation Filters
dialog, click the icon in the Fragments table.

DescriptionFilter

Rings and Double Bonds

• Integer value (even-electron): Shows only fragments that have
an integer value for rings and double bonds.

• Non-integer value (odd-electron): Shows only fragments that
have a non-integer value for rings and double bonds.

RDB

Mass Range
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DescriptionFilter

Shows only fragments with anm/z value that is within the specified
range.

m/z from __ to __

Mass Accuracy

Shows only fragments with a mass accuracy that is within the
specified range.

Note:Whether the mass accuracy is measured in mDa or ppm
depends on the selection in the Options dialog.

Accuracy within

Intensity

Shows only fragments with an intensity value that is above the
specified value.

Intensity above __ cps

Score

Shows only fragments with a score that is above the specified value.Score above

Structures

Shows only fragments that are associated with structures.Fragments with assigned
structures

Peptide Workflows
Load a Sequence

Edit a Sequence

Set Options

Assign Fragment Sequences

Add a Peak Label to the MS/MS SpectrumAbout Peak Labels

About Interpretation Filters for Peptides

Load a Sequence

1. In the Workspace panel, click Results.
2. Click Open.

The Open Results dialog opens.

3. Browse to and then select a Results file.
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4. Click OK.
5. In the Show field, select Interpretation.
6. Select a row in the Potential Metabolites table.

7. Do one of the following:

• If the Sequence pane is blank, then click Load Parent.
• If a sequence already exists in the Sequence pane, and a new sequence needs to be

added, then click Enter Sequence to clear the pane and then click Load Parent.
The parent sequence is shown in the Sequence pane. The following label is added above
the pane: AA Index: [ ], Mono. Mass: [ ], m/z: [ ], Composition: [ ], where:

• AA Index: (Amino Acid Index) The amino acid indices indicate the position of the first
and last residue of the sequence in the parent sequence. If the catabolite sequence is
not a subset of the parent sequence, then the AA Index is not shown.

• Mono. Mass: The monoisotopic mass of the neutral component.
• m/z: The mass-to-charge value. The charge is shown in brackets.
• Composition: The uncharged element composition of the sequence.

8. If changes are required, then edit the sequence. Refer to the section: Edit a Sequence.

Edit a Sequence

After a sequence for a specific metabolite is created or loaded, it can be edited.

1. Click in the sequence where the changes are required.

2. Make the required changes. Refer to the section: Peptide Sequence Naming Conventions.

Set Options

1. In the Interpretation view, click Options.
The Options dialog opens.

2. Modify the fragmentation and labeling parameters. Refer to the table: Table 8-16.
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Table 8-16 Options Dialog

DescriptionOption

Use this field to specify the threshold used to assign fragment peaks.
Peaks below this threshold will not be assigned. Noise is defined
as the peak with the smallest intensity in the MS/MS spectrum.

Minimum
signal-to-noise ratio

Use this field to specify the MS/MS m/z tolerance. For a fragment
peak to be assigned an ion type and a sequence, the mass accuracy
must fall within the MS/MS m/z tolerance specified.

MS/MS m/z
tolerance (ppm or
mDa)

Fragmentation Settings

Select the appropriate fragment type. Multiple types can be selected.
Options include:

• a
• b
• y

Fragment Types

Use this field to specify the maximum number of bonds to break.
Options include:

• 1
• 2
• 3

Tip! For more complex peptides, selecting 3 as the maximum
number of bonds to break results in an increase in the amount of
processing time required.

Maximum number
of bonds to break

If there are linkages in the peptide sequence, then select this check
box to allow the linkages between individual amino acids to be
broken.

Break linkages

Label Settings
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Table 8-16 Options Dialog (continued)

DescriptionOption

Use this field to specify the information that should be shown in the
peak labels. Options include:

• Ion
• Ion with ppm Error
• Ion with mDa Error
• Ion with Charge

Label peaks with

Select this check box to apply the current options to all unassigned
metabolites.

Apply options to all
potential
metabolites

Assign Fragment Sequences

Note: The fragmentation rules are embedded in the software and cannot be edited.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. In the Show field, select Interpretation.
6. Load a sequence. Refer to the section: Load a Sequence.

7. In the Sequence pane, click Assign.
The Fragments table is populated with the interpretation results for the loaded sequence,
using the options selected. Refer to the section: Set Options. Green vertical lines, identifying
the ions that are matched in the Fragments table, are added to the MS/MS pane. The label
above the table is updated to indicate:

• Assigned: x of y peaks. Indicates the number of peaks that have been assigned.
• MSMS Peak Area Assigned: x%. Indicates the percentage of the MS/MS peak area

that has been assigned.
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• Sequence Coverage: x of y consecutive amino acids. Indicates the number of
consecutive amino acids that are covered by the sequence.

About the Sequence Candidates Tab

When automatic sequence generation is used, the Sequence Candidates tab in the Sequence
charts pane is populated with a list of sequences for the selected catabolite or metabolite that
satisfy the conditions set in the Options dialog. Refer to the section: Batch Processing Options.
The software generates sequences for the following types of metabolites or catabolites:

• n cleavages: up to four modifications on the cleavages

• parent: where n refers to any number of cleavages

The list of sequences (referred to as the histogram) contains the following columns of information:

DescriptionColumn

Indicates the relative ranking of all the isomer sequences found for the
specified metabolite. The rank is based on the MS/MS peak area assigned.

Rank

The percentage values indicate the scoring of the proposed sequence.

This column also enables the user to toggle between sequences. Refer to
the section: Toggle Between Sequences.

View sequence
fragments

Indicates the amino acid start and end of the sequence.AA Index

A selected check box indicates that the corresponding sequence will be saved
for the Results file.

Apply to Results

The total number of candidates is shown above the histogram table, directly above the Apply to
Results column.
Auto-generated sequences cannot be edited. Users can load a sequence, make any necessary
modifications, and then select the Apply to Results check box to include the sequences in the
Results file. Refer to step 7 of the sections: Load a Sequence and Edit a Sequence.

About Peak Labels

A peak can be labeled with:

• An ion formula or ion type (for a peptide)

• An ion formula or ion type (for a peptide) and ppm error

• An ion formula or ion type (for a peptide) and mDa error

• An ion formula or ion type (for a peptide) with charge
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Add a Peak Label to the MS/MS Spectrum

1. In the Interpretation view, click Options.
The Options dialog opens.

2. In the Label peaks with field, select the label type.

3. Click OK.
4. Do one of the following:

Table 8-17 Add Peak Labels

To label all peaksTo label one peak

ClickIn the Fragments table, select the row
containing the peak to be labeled.

—Click .

Tip! To remove all labels from the MS/MS spectrum, click .

About Interpretation Filters for Peptides

Apply filters to refine the data shown in the Fragments table. To access the Interpretation Filters
dialog, click the icon in the Fragments table.

DescriptionFilter

Mass Range

Shows only fragments with anm/z value that is within the specified
range.

m/z from __ to __

Charge Range

Shows only fragments with a charge that is within the selected range.
Options include:

• From range: 1 to 10, inclusive
• To range: 1 to 10, inclusive

Note: The to range value must be greater than or equal to the
from range value.

Charge from __ to __
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DescriptionFilter

Ion Type

Select the appropriate fragment type. Multiple types can be selected.
These options are available:

• a
• b
• y

Fragment type

Mass Accuracy

Shows only fragments with a mass accuracy that is within the
specified range.

Note:Whether the mass accuracy is measured in mDa or ppm
depends on the selection in the Options dialog.

Accuracy within

Intensity

Shows only fragments with an intensity value that is above the
specified value.

Intensity above __ cps

Oligonucleotide Workflows
Load a Sequence

Edit a Sequence

Set Options

Assign Fragment Sequences

Add a Peak Label to the MS/MS SpectrumAbout Peak Labels

About Interpretation Filters for
Oligonucleotides

Load a Sequence

1. In the Workspace panel, click Results.
2. Click Open.

The Open Results dialog opens.

3. Browse to and then select a Results file.
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4. Click OK.
5. In the Show field, select Interpretation.
6. Select a row in the Potential Metabolites table.

7. If the Sequence pane is blank, then do one of the following:

• Click Load Parent.
• Type or paste a sequence in the pane.
The following label is added above the pane: Mono. Mass: [ ], m/z: [ ], Composition: [ ],
where:

• Mono. Mass: The monoisotopic mass of the neutral component.
• m/z: The mass-to-charge value. The charge is shown in brackets.
• Composition: The uncharged element composition of the sequence.

8. If changes are required, then edit the sequence. Refer to the section: Edit a Sequence.

Edit a Sequence

After a sequence for a specific metabolite is created or loaded, it can be edited.

1. Click in the sequence where the changes are required.

2. Make the required changes. Refer to the section: Oligonucleotide Sequence Naming
Conventions.

Set Options

1. In the Interpretation view, click Options.
The Options dialog opens.

2. Modify the fragmentation and labeling parameters. Refer to the table: Table 8-18.

Table 8-18 Options Dialog

DescriptionOption

Use this field to specify the threshold used to assign fragment peaks.
Peaks below this threshold are not assigned. Noise is defined as
the peak with the smallest intensity in the MS/MS spectrum.

Minimum
signal-to-noise ratio

Use this field to specify the MS/MS m/z tolerance. For a fragment
peak to be assigned an ion type and a sequence, the mass accuracy
must fall within the MS/MS m/z tolerance specified.

MS/MS m/z
tolerance (ppm or
mDa)
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Table 8-18 Options Dialog (continued)

DescriptionOption

Fragmentation Settings

Select the appropriate fragment type. Multiple types can be selected.
Options include:

• a
• b
• c
• d
• y
• Other
• wb-H20
• x
• y
Refer to the section: Example Custom Oligonucleotide.

Fragment Types

Use this field to specify the maximum number of bonds to break.
Options include:

• 1
• 2
A value of 2 is recommended.

Tip! For more complex oligonucleotides, selecting 3 as the
maximum number of bonds to break results in an increase in the
amount of processing time required.

Maximum number
of bonds to break

Specifies the maximum water losses that can occur during
fragmentation. A value of 1 is recommended.

Maximumwater and
Base losses

Label Settings
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Table 8-18 Options Dialog (continued)

DescriptionOption

Use this field to specify the information that should be shown in the
peak labels. Options include:

• Ion
• Ion with ppm Error
• Ion with mDa Error
• Ion with Charge

Label peaks with

Select this check box to apply the current options to all unassigned
metabolites.

Apply options to all
potential
metabolites

Assign Fragment Sequences

Note: The fragmentation rules are embedded in the software and cannot be edited.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. In the Show field, select Interpretation.
6. Load a sequence. Refer to the section: Load a Sequence.

7. In the Sequence pane, click Assign.
The Fragments table is populated with the interpretation results for the loaded sequence,
using the options selected. Refer to the section: Set Options. Cyan vertical lines, identifying
the ions that are matched in the Fragments table, are added to the MS/MS pane. The label
above the table is updated to indicate:

• Assigned: x of y peaks. Indicates the number of peaks that have been assigned.
• MSMS Peak Area Assigned: x%. Indicates the percentage of the MS/MS peak area

that has been assigned.
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• Sequence Coverage: x of y consecutive nucleotides. Indicates the number of
consecutive nucleotides that are covered by the sequence.

About Peak Labels

A peak can be labeled with:

• An ion formula or ion type (for a oligonucleotide)

• An ion formula or ion type (for a oligonucleotide) and ppm error

• An ion formula or ion type (for a oligonucleotide) and mDa error

• An ion formula or ion type (for a oligonucleotide) with charge

Add a Peak Label to the MS/MS Spectrum

1. In the Interpretation view, click Options.
The Options dialog opens.

2. In the Label peaks with field, select the label type.

3. Click OK.
4. Do one of the following:

Table 8-19 Add Peak Labels

To label all peaksTo label one peak

ClickIn the Fragments table, select the row
containing the peak to be labeled.

—Click .

Tip! To remove all labels from the MS/MS spectrum, click .

About Interpretation Filters for Oligonucleotides

Apply filters to refine the data shown in the Fragments table. To access the Interpretation Filters
dialog, click the icon in the Fragments table.
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DescriptionFilter

Mass Range

Shows only fragments with anm/z value that is within the specified
range.

m/z from __ to __

Charge Range

Shows only fragments with a charge that is above the selected
value. Valid values are from 1 to 10.

Charge from __ to __

Ion Type

Select the appropriate fragment type. Multiple types can be selected.
These options are available:

• a
• b
• c
• d
• w
• wb-H20
• x
• y
• Other
• Base loss
• Water loss
• Internals

Fragment type

Mass Accuracy

Shows only fragments with a mass accuracy that is within the
specified range.

Note:Whether the mass accuracy is measured in mDa or ppm
depends on the selection in the Options dialog.

Accuracy within

Intensity

Shows only fragments with an intensity value that is above the
specified value.

Intensity above __ cps
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ADC Workflow
Load a Structure

Edit a Structure

Load a Sequence

Edit a Sequence

Set Options

Assign Fragment Ions for Both Structure
and Sequence

Add a Peak Label to the MS/MS SpectrumAbout Peak Labels

About Interpretation Filters for ADC

Load a Structure

Before starting structural elucidation of a metabolite, loading a structure enables the software to
determine potential fragment structures.

Note: If a structure is not loaded, then potential formulas can still be assigned to fragments.

1. In the Workspace panel, click Results.
2. Click Open.

The Open Results dialog opens.

3. Browse to and then select a Results file.

4. Click OK.
5. In the Show field, select Interpretation.
6. Select a row In the Potential Metabolites table.

7. In the Structure pane, click Load and then select the Load Parent Structure option.
The pane is populated with the parent structure of the selected metabolite. The marked site
of the attachment (as seen in the embedded processing parameters file) or the anchor
atoms are shown in purple.

8. If minor changes are needed, then edit the structure. Refer to the section: Edit a Structure.

Edit a Structure

After loading a structure for a specific metabolite, use the editing tools to make minor changes.
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Tip! Use the editing tools to make minor changes to a structure, such as different attachment
positions for a metabolic transformation. The editing tools should not be used to create new
structures or make major changes to existing structures.

Table 8-20 Edit a Structure

Do thisTo do this

Drag a specific symbol on the palette to the new position.
The added atom forms a single bond with the closest
existing atom.

Add an atom to a structure

Click a blank square, type the symbol in the Specify
Symbol dialog, and then click OK.

Tip! Click the added square and type a new symbol to
create different atoms.

Create new atoms on the palette

Drag a circle around the required atoms and bonds.Highlight a portion of the structure

Drag a highlighted portion of the structure to the new
position. If the portion is bonded to one other atom, then
the bond moves to the new position. If the portion is
bonded to two or more atoms, then the portion moves but
the existing bonds remain the same.

Move one or more atoms

Right-click the structure and click one of the following:

• Insert .mol File to add another structure.
• Insert Conjugate to add a specific conjugate structure.

Insert a structure into an existing
structure

Right-click a highlighted portion of the structure and then
click Remove Selected Atoms.

Delete one or more atoms

Select two non-bonded atoms, right-click the selection,
click New Bond, and then select the type of bond.

Create a bond

Right-click a bond, click Set Bond Type, and then select
the type of bond.

Edit a bond

Right-click a bond and then click Remove Bond.Delete a bond

Right-click the atom, click Atom Charge State, and then
select the state.

Change the charge state of an existing
atom
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Tip! To save the edited structure as a separate file, click Save As.

Tip! Structures can be saved as either mol or sdf files. Type the appropriate extension in the
Save As dialog.

Load a Sequence

1. In the Workspace panel, click Results.
2. Click Open.

The Open Results dialog opens.

3. Browse to and then select a peptide Results file.

4. Click OK.
5. In the Show field, select Interpretation.
6. Select a row in the Potential Metabolites table.

7. In the Structure pane, click Load and then select the Load Sequence option.
The Sequence pane is populated with the parent sequence of the selected metabolite.

8. Select the residue to be conjugated on, right-click and then select Mark Residue to
Conjugate.
The selected residue is shown in purple.

9. If changes are required, then edit the sequence. Refer to the section: Edit a Sequence.

Edit a Sequence

After a sequence for a specific metabolite is created or loaded, it can be edited.

1. Click in the sequence where the changes are required.

2. Make the required changes. Refer to the section: Peptide Sequence Naming Conventions.

Set Options

1. In the Interpretation view, click Options.
The Options dialog opens.

2. Modify the fragmentation and labeling parameters as described in the table: Table 8-21.
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Table 8-21 Options Dialog

DescriptionOption

Use this field to specify the number of fragment peaks that will be
assigned for the structure portion of the ADC. If it is a subset of the
total number of peaks, then peaks are chosen in order of their
intensities.

Number of fragment
peaks selected for
structure
assignment

Use this field to specify the threshold used to assign fragment peaks.
Peaks below this threshold will not be assigned.

Minimum
signal-to-noise ratio

Use this field to specify the MS/MS m/z tolerance, in ppm or mDa.
For a fragment peak to be assigned a formula and potentially a
structure, its mass accuracy must fall within the MS/MS m/z
tolerance specified.

MS/MS m/z
tolerance (ppm or
mDa)

Structure Fragmentation Settings

Select this check box to break the aromatic ring.Break aromatic
rings

Use this field to specify the maximum number of bonds to break.
Options include:

• 1
• 2
• 3
• 4

Maximum number
of bonds to break

Use this field to specify themaximum number of C-C bonds to break.
Options include:

• 0
• 1
• 2
• 3
• 4

Maximum number
of C-C bonds to
break

Sequence Fragmentation Settings
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Table 8-21 Options Dialog (continued)

DescriptionOption

Select the appropriate fragment type. Multiple types can be selected.
Options include:

• a
• b
• y

Fragment Types

Use this field to specify the maximum number of bonds to break.
Options include:

• 1
• 2
• 3

Note: For more complex peptides, selecting 3 as the maximum
number of bonds to break results in an increase in the amount of
processing time required.

Maximum number
of bonds to break

If there are linkages in the peptide sequence, then select this check
box to allow the linkages between individual amino acids to be
broken.

Break linkages

Label Settings

Use this field to specify the information that should be shown in the
peak labels. Options include:

• Ion
• Ion with ppm Error
• Ion with mDa Error
• Ion with Charge

Label peaks with

Select this check box to apply the current options to all unassigned
metabolites.

Apply options to all
potential
metabolites
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Assign Fragment Ions for Both Structure and Sequence

Note: The fragmentation rules are embedded in the software and cannot be edited.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. In the Show field, select Interpretation.
6. Load a structure and a sequence. Refer to the section: Load a Structure and Load a

Sequence.

Note: Only one of a structure or a sequence must be loaded. This procedure is written
based on the assumption that both have been loaded.

7. In the Structure pane, click Assign.
Both the Structure view and the Sequence view under the TOFMS/MS spectra are populated,
with the Structure view shown, by default.

Note: If only the parent structure was loaded, then the Structures view of the Fragments
table is shown. If only the parent sequence was loaded, then the Sequences view of the
Fragments table is shown.

In the Structure view, the Fragments table is populated with the identified fragments, the
Structure Details table is populated with the potential structures, and the Contained Neutral
Losses table is populated with the contained neutral losses. The results are based on the
options selected. Refer to the section: Set Options. Light blue vertical lines, identifying the
ions that are matched in the Fragments table, are added to the MS/MS pane.

Note: If the structure has no interpretation results, then No structures assigned is shown
in the Fragments table.

The label above the Fragments table indicates:
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• Assigned: a of b peaks (Structure: x, Sequence: y), where a is the sum of x and y and
indicates the number of peaks that have been assigned, b indicates the total number of
peaks, x indicates the number of rows in the Structures view and y indicates the number
of rows in the Sequences view.

• MSMSPeak Area Assigned: w%, where w indicates the percentage area of the assigned
peaks from the spectral data.

The Fragments table contains a Use as Conjugate column. This column contains a check
for each row in the table. If the check box is available for selection, then a site of attachment
is present on the proposed structure for the fragment. If the check box is not available for
selection, then a site of attachment is not present. If the check box is selected, then the
fragment is used for conjugation with the sequence. If the check box is not selected, then
the fragment is not used. By default, a maximum of three fragments that contain a site of
attachment are selected, based on accuracy and abundance. The first row in the table is
selected by default.

8. Make sure that the Structures view is selected.

9. If appropriate, right-click each of the Fragments, Structure Details, and Contained Neutral
Losses tables and then click Show Hidden Rows.

Note: In the Fragments table, the row containing the highest score for the m/z value has
the Use check box selected. In the Structure Details table, the row with the highest score
has the Use check box selected. In the Contained Neutral Losses table, all rows have the
Use check box selected.

10. In the Fragments table, select the Use check box to identify the row that contains the most
accurate formula for each m/z value.

Tip! Select the Use check box in more than one row to select multiple potential formulas
for each fragment.

The assigned m/z value is shown in bold, italicized font.

11. In the Structure Details table, select theUse check box to identify the portions of the structure
that most accurately match the selected formula.

12. In the Contained Neutral Losses table, select the Use check box to identify the row that
most accurately reflects the contained neutral losses.

Tip! In the Structure Details and Contained Neutral Losses tables, select the Use check
box in more than one row for a particular fragment.

13. Select the Sequences view.
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In the Sequence view, the Fragments table is populated with the results of the interpretation,
based on the options selected (refer to the section: Set Options), the conjugates selected
in the Structures view, the selections made on the Product Ions and Neutral Losses tab of
the Compound-Specific Parameters (refer to the section: Product Ions and Neutral Losses
Tab), and the sequence. Green vertical lines, identifying the ions that are matched in the
Fragments table, are added to the MS/MS pane.

Note: If the sequence has no interpretation results, then No sequences assigned is shown
in the Fragments table.

The label above the table indicates:

• Assigned: a of b peaks (Structure: x, Sequence: y), where a is the sum of x and y and
indicates the number of peaks that have been assigned, b indicates the total number of
peaks, x indicates the number of rows in the Structures tab and y indicates the number
of rows in the Sequences tab.

• MSMSPeak Area Assigned: w%, where w indicates the percentage area of the assigned
peaks from the spectral data.

14. If appropriate, right-click the Fragments table and then click Show Hidden Rows.

Note: In the Fragments table, the row containing the highest score for the m/z value has
the Use check box selected.

15. In the Fragments table, select the Use check box to identify the row that contains the most
accurate formula for each m/z value.

Tip! Select the Use check box in more than one row to select multiple potential formulas
for each fragment.

The assigned m/z value is shown in bold, italicized font.

16. After all changes have been made, click Apply.
The interpretation data is saved for the selected metabolite.

17. Click Save.

Tip! To delete all interpretation data for a specific metabolite, click Remove.

About Peak Labels

A peak can be labeled with:

• An ion formula or ion type (for a peptide)
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• An ion formula or ion type (for a peptide) and ppm error

• An ion formula or ion type (for a peptide) and mDa error

• An ion formula or ion type (for a peptide) with charge

Add a Peak Label to the MS/MS Spectrum

1. In the Interpretation view, click Options.
The Options dialog opens.

2. In the Label peaks with field, select the label type.

3. Click OK.
4. Do one of the following:

Table 8-22 Add Peak Labels

To label all peaksTo label one peak

ClickIn the Fragments table, select the row
containing the peak to be labeled.

—Click .

Tip! To remove all labels from the MS/MS spectrum, click .

About Interpretation Filters for ADC

Apply filters to refine the data shown in the Fragments table. To access the Interpretation Filters
dialog, click the icon in the Fragments table.

DescriptionFilter

Rings and Double Bonds

• Integer value (even-electron): Shows only fragments that have
an integer value for rings and double bonds.

• Non-integer value (odd-electron): hows only fragments that
have a non-integer value for rings and double bonds.

RDB

Mass Range

Shows only fragments with anm/z value that is within the specified
range.

m/z from __ to __
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DescriptionFilter

Charge Range

Shows only fragments with a charge that is within the selected range.
Options include:

• From range: 1 to 10, inclusive
• To range: 1 to 10, inclusive

Note: The to range value must be greater than or equal to the
from range value.

Charge from __ to __

Ion Type

Select the appropriate fragment type. Multiple types can be selected.
Options include:

• a
• b
• y

Fragment type

Mass Accuracy

Shows only fragments with a mass accuracy that is within the
specified range.

Note:Whether the mass accuracy is measured in mDa or ppm
depends on the selection in the Options dialog.

Accuracy within

Intensity

Shows only fragments with an intensity value that is above the
specified value.

Intensity above __ cps

Score

Shows only fragments with a score that is above the specified value.Score above

Structures

Shows only fragments that are associated with structures.Fragments with assigned
structures
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Automatic Interpretation
Automatic Interpretation

Peptide WorkflowsSmall Molecule Workflow

Small Molecule Workflow
Automatic generation of structures can be started in the following ways:

• In the Batch workspace, select the Apply Options check box to apply all of the Auto Assign
options chosen in the Batch Processing Options dialog to the samples and control samples in
the batch. At a minimum, the Assign Structures or Sequences option must be selected. Refer
to the section: Batch Processing Options.

• In the Interpretation view of the Results workspace, click Generate in the MS/MS pane.

Peptide Workflows
Automatic generation of sequences can be started in the following ways:

• In the Batch workspace, select the Options check box to apply all of the Auto Assign options
chosen in the Batch Processing Options dialog to the samples and control samples in the batch.
At a minimum, the Assign Structures or Sequences option must be selected. Refer to the
section: Batch Processing Options.

• In the Interpretation view of the Results workspace, click Generate in the MS/MS pane.

Toggle Between Sequences

• Click a blue bar in the histogram.

The corresponding sequence is shown in the Sequence pane and the Fragments table is
updated with the information related to the selected sequence. The label above the Sequence
pane is updated to indicate the sequence number and the assigned rank. For example,
Sequence x of y, rank = z.

Select an Empty Pane

• Click the first line in the histogram.
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The first line in the histogram contains the words No sequence. The Sequence pane is
cleared and the Fragments table refreshes, with the words No sequences assigned shown.

Add a Sequence

Note: Only one sequence can be added to the list of auto-generated sequences. If an additional
sequence is added, then the previous user-added sequence is overwritten.

1. In the Sequence pane, click Enter Sequence.
The Sequence pane is cleared and the Fragments table refreshes with the words No
sequence assigned shown.

2. Click Load Parent.
The parent sequence is shown in the Sequence pane and on the Parent Sequence tab of
the Sequence charts pane.

3. Press Tab to validate the parent sequence.

An underline is added to the sequence to indicate that it is valid. A new histogram is created
on the Sequence Candidates tab, showing the user-added sequence in the line immediately
above the first auto-generated sequence. The ranking for the user-added sequence will be
0. The blue bar will span the entire width of the table. However, the percentage will not be
shown in the bar. The shade of blue for the loaded sequence row will be slightly different
than the blue for the lines containing the auto-generated sequences. The number of
sequences proposed will increase by one.

The user-added sequence can be edited. Any changes made to the sequence will be held
in memory when the user tabs out of the Sequence pane.

Select a Sequence to View

• Click a blue bar in the histogram.

The corresponding sequence is shown in the Sequence pane. The Fragments table is
updated with the information related to the selected sequence. The label above the Sequence
pane is updated to indicate the sequence number and the assigned rank. For example,
Sequence x of y, rank = z.

Delete a Sequence

1. Click a blue bar in the histogram.

The corresponding sequence is shown in the Sequence pane.

2. In the Sequence pane, click Delete.
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The sequence is removed from the Sequence pane and the row is removed from the
histogram. The sequence of the next line in the histogram is shown in the Sequence pane
and the Fragments table is updated with the information related to the selected sequence.
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When potential metabolites are found in several samples of interest, the results from each sample
can be compared. This allows the user to see the differences and the similarities between the
potential metabolites generated by several Results files. Metabolites from the different Results
files are considered to be identical if they match the mass-to-charge ratio and retention time
tolerances set in the Correlate Results dialog.

For oligonucleotide workflows, the software can group multiply charged metabolites with the same
neutral mass and within the retention time tolerance in a single entry in the Correlation workspace.
This feature is called Grouping. To enable the feature, select Group results by analyte when
correlating the results. When the feature is enabled, multiply charged species are merged, facilitating
comparison across Results files.

Note: Enable the group feature before correlating the Results files.

Prepare for Correlation
1. Click File > New > Correlation.

The Correlate Results dialog opens.

2. Click Add Results.
The Open Results dialog opens.

3. Browse to and then select the appropriate files.

Note: The selected files can contain different compounds. Analog data is not required for
correlation.

4. Complete the X-axis title and the X-axis units fields.
This assigns a label for the X-axis of the graphs in the Correlation workspace.

5. Type a unique value beside each Results file in the field corresponding to the X-axis label.
For example, if the label assigned in step 4 is Time, then type the time for each Results
file in the Time field.

6. Select Include RRF in % area determination, if appropriate.
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Note: Do not select both Include RRF in % area determination and Group results by
analyte.

If this option is selected, then the MS Area will be multiplied by the relative response factor.
The change in area is shown in the Linear Graph, Bar Graph, and Table views of the
Correlations Details pane. The change is not shown in the Potential Metabolites table.

7. (Oligonucleotide workflow) If required, select theGroup results by analyte to group peaks
based on neutral mass.

8. Customize the correlation. Refer to the section: Customize the Correlation.

9. In the Correlation file name field, type a name for the file.

Note: Do not include spaces in the file name.

10. To select a specific location to save the correlation file, click Browse and then select the
appropriate folder.

11. Click OK.
The software compares the metabolites found in the selected files and shows the results
in the Correlation workspace.

Tip! The same correlation can be processing using different settings. In the Correlation
workspace, click Correlate Results.

Customize the Correlation
After selecting the files to correlate, edit the parameters values in the Correlation Results dialog
to improve the results.

Improve Peak Alignment
The retention times of individual Results files can be shifted to better correlate the selected files.

1. Before correlating results, do this:

a. Open each of the appropriate Results file in the Results workspace.

b. Review the retention time of a specific metabolite that is shown in all of the files.

2. Based on the shift that is shown in the Results file, in the Correlate Results dialog, type a
value in the R.T. Shift (min) field beside the specific file.

Note: The R.T. Shift (min) field accepts values from –2.00 minutes to 2.00 minutes.
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Define Peak Merging
Specific tolerances allow peaks with similar values to be considered the same peak.

1. Open each of the Results files in the Results workspace.

2. Identify the retention time and mass tolerance of a specific metabolite that is shown in all
of the files.

3. In the Correlate Results dialog, in the Tolerances group, type a value in the Retention time
field.

Note: The Retention time field accepts values between 0.01 minutes and 0.25 minutes.

4. Type a value in theMSm/z field and then select either ppm ormDa as the unit of measure.

Note: In oligonucleotide workflows, if the Group results by analyte option is selected,
then only ppm is available.

Note: The MS m/z field accepts values between 0.1 and 250.0.

About the Correlation Workspace
The Correlation workspace shows the comparison of potential metabolites that were found in the
selected Results files.
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Figure 9-1 Correlation Workspace
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DescriptionItem

Menu bar. The menu bar contains these buttons:
• Correlate Results: Opens the Correlate Results dialog. Refer to the

section: Prepare for Correlation.

• Open: Opens the Open Correlation dialog where users can browse to the
appropriate correlation files.

• Save: Saves the currently open correlation file. Automatically replaces the
existing version.

• Save As : Saves the currently open correlation file. Optionally, select the
destination folder and assign a new name to the correlation file.

1

Potential Metabolites pane. Lists all of the correlated peaks based on the set
tolerances. Each row lists a correlated potential metabolite, theMSArea, and
the Analog Area, if applicable, from the Results files. An emptyMS Area cell
indicates that the metabolite was not found in the specific Results file. An
empty Analog Area cell indicates that either the metabolite was not found in
the Results file or the analog response was zero.

This pane contains these buttons:

• Select values to filter peaks from the results. ( ): Opens the Correlation
Filters dialog where users can set values that will filter information that
does not meet the criteria from the results. Refer to the section: About
Correlation Filters.

• Assign ID: Assigns a unique identifier to each peak in the Potential
Metabolites table, based on the retention time and the m/z value.

2

Correlation Details pane. Allows users to compare correlated metabolites.
Refer to the section: Compare Correlated Metabolites. Different metabolites
and Results files can be selected. MS and analog data can be presented in
the following formats:
• Linear Graph or Bar Graph: Compares the intensity of each metabolite

in each of the Results files in which it was found.

• Table: Identifies the Results files in which each metabolite was found.
Users can also select to show the occurrence, peak ID, or peak area in
the table.

Note: If a relative response factor was applied when preparing for correlation,
then quantitative MS data is shown in the linear graphs and the bar graphs.

3
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DescriptionItem

Chromatograms pane: Shows either an extracted ion chromatogram (XIC) or
an analog chromatogram for the selected metabolite. The chromatograms
can include data from one or from all of the Results files containing the
metabolite.

4

MS pane: Shows the MS spectrum of the sample of interest from one or from
all of the Results files containing the selected metabolite.

5

MS/MS pane: Shows the MS/MS spectrum of the selected metabolite from
one or from all of the Results files containing the metabolite.

6

Note: If correlation results are grouped, then chromatographic, MS and MS/MS spectra are not
shown.

Edit the Name of a Correlated Metabolite
1. In the Workspace panel, click Correlation.

The Correlation workspace opens.

2. Click Open.
The Open Correlation dialog opens.

3. Browse to and then select the appropriate correlation file.

4. Select a row in the Potential Metabolites table.

5. Click Edit > Edit Name.
The Edit Name dialog opens.

6. Type a new metabolite name.

7. Click OK.
The metabolite name changes to the new value.

Compare Correlated Metabolites
After correlating the metabolites contained in multiple Results files, users can compare selected
specific metabolites in more detail.

1. In the Workspace panel, click Correlation.
The Correlation workspace opens.
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2. Click Open.
The Open Correlation dialog opens.

3. Browse to and then select the appropriate file.

4. In the Potential Metabolites table, select the Plot check box beside the potential metabolites
to be compared.

The metabolites are shown in the Correlation Details pane.

5. To change the relative response factor of a specific metabolite, type a value in the RRF
field.

In the Linear graph and Bar graph, the MS area and the Analog area, if applicable, are
multiplied by the RRF value.

Note: This field is shown only if a relative response factor was used when preparing for
correlation.

6. To show analog data in the Correlation Details pane, click Analog data.
7. To identify the files that contain the selected metabolites, select Table in the Correlation

Details pane.

8. To show normalized data, click .

Tip!Normalized data can be shown in the Linear graph, the Bar graph, the XIC, the analog
chromatogram, the MS spectrum, and the MS/MS spectrum.

9. To reassign the peak IDs of the Potential Metabolites in the correlated files, based on the
retention time and the m/z value, click Assign ID.

About Correlation Filters
Apply filters to further refine the data shown in the Correlation table. Click the icon to access
the Correlation Filters dialog or click Setup > Filters > Correlation.

DescriptionFilter

Mass Range

Shows only peaks with an m/z value that is within the specified
range.

m/z from __ to __

Retention Time
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DescriptionFilter

Shows only peaks with a retention time that is within the specified
range.

R.T. from __ to __

Occurrence

Shows only peaks that are shown in the specified number of Results
files.

Note: Themaximum value depends on the number of files selected
for correlation. For example, if five Results files are selected to
correlate, then a maximum of five occurrences of a peak can be
selected.

Peaks in __ or more
results files
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To generate reports with the software, Microsoft Word 2010 or higher must be installed on the
computer.

Users can create reports in Adobe PDF, Microsoft Word, and HTML. A report can also be sent
directly to a printer.

The following report templates are installed with the software in the C:\ProgramData\SCIEX\Molecule
Profiler\Report Templates folder:

• Correlation folder

• Correlation Detailed Report

• Correlation Summary Report

• Correlation Group Report

• ResultsAndInterpret folder

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_ADC folder

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_Peptides folder

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report
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• ResultsAndInterpret_Oligo folder

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

Although each report can contain many pieces of information, the report only shows the contents
of the Results file being reported at the time that the report is generated. If the Results file does
not contain a specific piece of information, for example, isotopic enrichment, then the generated
report will not contain that content and, in most cases, will not contain a field label or heading for
that content. Any filters that have been applied to the Potential Metabolites table or the Fragments
table are reflected in the report. For example, if the Potential Metabolites table is filtered to show
only the top 5 of 23 peaks, only those 5 peaks are included in the report.

All graphs or spectra included in the report are shown at the default zoom level, regardless of the
zoom level that has been selected in the user interface. All correlation graphs are reported with
non-normalized data.

Note:When creating custom correlation report templates for use with grouped data, make sure
to include "grouped" in the file name.

Create a Report in the Results Workspace
A report can be created for each of the small molecule, peptides, and ADC results.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.

3. Browse to and then select the appropriate file.

4. Click OK.
The Results view is shown.

5. In theReport column, select the corresponding check box for each metabolite to be included
in the report.

Metabolites that are not selected are not included in the generated report.

6. In the Workflow panel, click Create Report.
The Create Report dialog opens.
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7. Select a template for the report from the Available templates field.
For a list of templates, refer to the section: Reports.

8. Select the appropriate Formats check boxes to create the required versions of the report
files or to print the report.

Note: Multiple formats can be selected.

9. For each format version selected, click Browse and then, on the Browse For Folder dialog,
browse to and select a specific storage location for the report file.

10. Click OK.
The Browse For Folder dialog closes.

11. For each format version selected, type a name for the report in the field provided.

12. (Oligonucleotide workflow) Select or clear the Report grouping table for Results check
box, as required.

13. Click Generate Report.
14. If the Print report option was selected, then select the required print options on the Print

dialog and click OK.
The software generates the report.

Create a Report in the Correlation Workspace
A correlation report can be created for each of the small molecule, peptides, and ADC results.

1. In the Workspace panel, click Correlation.
The Correlation workspace opens.

2. Click Open.
The Open Correlation dialog opens.

3. Browse to and then select the appropriate file.

4. Click Open.
The Correlation Results view is shown.

5. To include the correlation details for the metabolite of interest in the report, select the Plot
check box.

6. In the Workflow panel, click Create Report.
The Create Report dialog opens.
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7. Select a template for the report from the Available templates field.
For a list of templates, refer to the section: Reports.

Note: If the correlation file does not contain grouped data, then only ungrouped report
templates are available. If the correlation file contains grouped data, then only report
templates with "grouped" in the file name are shown.

8. Select the appropriate Formats check boxes to create the required versions of the report
files or to print the report.

Note: Multiple formats can be selected.

9. For each format version selected, click Browse and then, on the Browse For Folder dialog,
navigate to and select a specific storage location for the report file.

10. Click OK.
The Browse For Folder dialog closes.

11. For each format version selected, type a name for the report in the field provided.

12. Click Generate Report.
13. If the Print report option is selected, then select the required print options on the Print

dialog and click OK.
The software generates the report.

Copy and Paste a Graph
Graphs can be copied from the Results workspace as well as the Compound Library and Processing
Parameters dialogs.

1. Right-click the graph to copy and then click Copy Selected Graph.
The graph is copied to the clipboard.

2. Paste the graph in another application, such as Microsoft Word.

Copy and Paste the Potential Metabolites Table
1. Right-click the table and then click Copy Table in the Results workspace.

The table is copied to the clipboard.

2. Paste the table in Excel.
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Analog data is used to confirm that metabolites found using the mass spectrometer are actual
metabolites and not false positives. Users who use analog in-line with the mass spectrometer will
use this feature to optimize analog area integration and better visualize the association of MS
peaks with analog peaks.

If a Results file that contains analog data is opened, then the Analog Integration button in the
Potential Metabolites table is enabled.

When Analog Integration is clicked, the Analog Integration dialog opens.

The original Potential Metabolites table from the Results workspace is shown, with the following
exceptions:

• Any analog peaks that do not have associated mass peaks are shown, but the MS-related
columns are empty.

• An additional column, Analog Signal in Control, is shown immediately after the Analog - R.T.
(min) column if analog control data exists. If there is no analog control data, this column is not
shown.

The Analog Signal in Control column provides the following information:
• If the sample-to-control ratio of the analog peak is greater than the value specified in the

Processing Parameters, then an x is shown in the column.

• If the sample-to-control ratio of the analog peak is less than the value specified in the Processing
Parameters, then a check mark is shown in the column.

Manually Integrate Analog Data
Prerequisites:

• Results have been processed with analog data.

1. In the Workspace panel, click Results.
The Results workspace opens.

2. Click Open.
The Open Results dialog opens.
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3. Browse to and then select the appropriate file.

Note: The Results file must contain an analog chromatogram.

4. Click OK.
The Results view is shown. If the Results file contains analog data, then the Analog
Integration button in the Potential Metabolites table is enabled. If the Results file does not
contain analog data, the button is not available.

5. Click Analog Integration.
The Analog Integration dialog opens.

In addition to the Potential Metabolites table, two chromatograms are shown. The first
chromatogram, the Analog Sample chromatogram, shows all of the analog peaks within
the retention time range specified in the Chromatographic Data tab of the Generic Processing
Parameters. Refer to the section: Chromatographic Data Tab. The second chromatogram,
the Extracted Ion Chromatogram (XIC) of the MS Sample, shows all of the peaks for the
selected row. The XIC is updated each time a different row is selected in the Potential
Metabolites table.

6. Select the Analog Sample chromatogram and then complete the following tasks, if required,
to integrate the data:

• manually integrate peaks

• modify the existing integration of peaks

• remove peaks
As the changes are made, the software automatically updates the Analog Sample
chromatogram.

7. (Optional) Select the Show Controls check box.
A maximum of five control samples are shown below the Analog Sample chromatogram
title. Refer to the section: Show Controls.

8. (Optional) Click Baseline Subtract.
Baseline subtract is applied to both the Analog Sample and to any controls. The phrase
"baseline subtracted" is appended to the title of the Analog Sample chromatogram and to
any controls. Refer to the section: Perform a Baseline Subtract.

9. (Optional) Change the R.T. Offset. Refer to the section: Change R.T. Offset.
The R.T. Offset applies to both the Analog Sample and the control traces.

10. (Optional) Apply the analog integrationOptions. Refer to the section: Set Analog Integration
Options.
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11. Do one of the following:

• Click Update Table. Refer to the section: Update Table.
• Click Update Results and Close. Refer to the section: Update Results and Close.

12. Do one of the following:

• Click Save to save the currently open Results file and overwrite the existing version.
• Click Save As to save the currently open Results file with a new name. The existing

Results file is not updated.

Show Controls
1. In the Chromatograms pane of the Analog Integration dialog, select the Show controls

check box.

If applicable, a maximum of five controls are shown below the Analog Sample title in the
Chromatograms pane. If applicable, a maximum of five controls are shown below the MS
Sample title in the XIC pane.

2. Click the icon to expand the list and show both the analog sample and the analog control
or the MS Sample and the MS Control.

3. Click the icon to collapse the list and show only the analog Sample or the MS Sample.

4. Select the Show controls check box again to remove the controls from the view.

Perform a Baseline Subtract
1. In the Chromatograms pane of the Analog Integration dialog, click Baseline Subtract.

The Analog Sample chromatogram is baseline subtracted. Baseline subtraction is applied
to both the analog sample and to any control traces. The phrase "baseline subtracted" is
appended to the name of the Analog Sample chromatogram.

2. Click Baseline Subtract again to remove the baseline subtraction.
The phrase "baseline subtracted" is removed from the name of the Analog Sample
chromatogram.

Change R.T. Offset
• In the Chromatograms pane of the Analog Integration dialog, use the up and down arrows

in the R.T. Offset field to change the retention time offset.
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The peaks in the Analog Sample chromatogram are shifted by the specified retention time
offset. When the Potential Metabolites table is updated or the results are updated, the values
in the Analog R.T. (min) column are updated to reflect the shift in the specified retention
time offset. The offset applies to both the analog sample and the control samples.

Set Analog Integration Options
1. In the Chromatograms pane of the Analog Integration dialog, click Options.

The Analog Integration Options dialog opens.

2. Select the check box for each option to be applied.

DescriptionOption

Overlays MSSample XICs for these traces with identical analog retention
times.

Overlay XIC for
peaks at the
same analog
retention time

Links the X-axis of the Analog Sample chromatogram and the XIC
chromatogram.

Link x-axis

3. Click OK.

Update Table
When changes are made in the Analog Integration dialog, the Update Table option is enabled.

• Click Update Table.
The information in the following columns of the Potential Metabolites table is updated to
reflect any changes made to the analog peak integration, the analog retention time, and
baseline subtraction:

• The assigned Peak ID for the Analog Sample chromatogram might be updated to reflect
any manual integration. The analog peak is considered a match with an MS peak if the
retention time of the analog peak matches the retention of the MS peak, within a specified
tolerance.

• The Analog - Peak Area is updated to reflect any new integrated areas.
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• The Analog - % Area is updated to reflect any changes in the algorithm. The Analog -
% Area is calculated based on all of the analog peaks, both those associated with MS
peaks and those not associated with MS peaks, within the time range specified in the
Processing Parameters. If an analog peak is associated with more than one MS peak,
then the analog peak area listed for a specific M# is calculated proportionally based on
the XIC MS area of that M#, using the peak areas of all the associated MS peaks as the
total.

• The Analog - R.T. (min) is updated to reflect any changes made to the retention time
offset.

Note: These changes are not saved in the Results file and can be reverted by clicking
Cancel.

Update Results and Close
When changes are made in the Analog Integration dialog, the Update Results and Close option
is enabled.

1. Click Update Results and Close.
A message opens, asking the user to confirm that the analog information should be updated
based on the changes made.

2. Click Yes.
The Analog Integration dialog closes. The information in the following columns of the Potential
Metabolites table is updated to reflect any changes made to the analog peak integration,
the analog retention time, and baseline subtraction:

• The assigned Peak ID for the Analog Sample chromatogram might be updated to reflect
any manual integration. The analog peak is considered a match with an MS peak if the
retention time of the analog peak matches the retention of the MS peak, within a specified
tolerance.

• The Analog - Peak Area is updated to reflect any new integrated areas.

• The Analog - % Area is updated to reflect any changes in the algorithm. The Analog -
% Area is calculated based on all of the analog peaks, both those associated with MS
peaks and those not associated with MS peaks, within the time range specified in the
Processing Parameters. If an analog peak is associated with more than one MS peak,
then the analog peak area listed for a specific M# is calculated proportionally based on
the XIC MS area of that M# (using the peak areas of all the associated MS peaks as the
total).
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• The Analog - R.T. (min) is updated to reflect any changes made to the retention time
offset.
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For help with a particular issue, select the appropriate link:

• Cannot Open a Structure File

• Change User Permissions

• No Potential Metabolites Found

• Too Many Potential Metabolites Found

• Long Processing Times

• Show the ProgramData Folder

• Known Issues and Limitations

Cannot Open a Structure File
Make sure that the structure file follows these conventions:

• Format: mol

• Version: v2000 or v3000

• Content: Does not contain text

Change User Permissions
When the Molecule Profiler software is installed, all users are given permission to read, write, and
delete files in the installed user data folder. If the permissions are changed, then the software
might not function correctly.

Note: The default location of the installed user folder is C:\ProgramData\SCIEX\Molecule Profiler
Data.

No Potential Metabolites Found
To find more metabolites in the sample of interest:
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• Select a different peak finding strategy. Refer to the section: About Peak Finding Strategies.

• Decrease the minimum chromatographic intensity on the Chromatographic Data tab. Refer to
the section: Chromatographic Data Tab.

• Increase the MS m/z tolerance in the m/z Tolerance group on the MS Parameters tab. Refer
to the section: MS Parameters Tab.

• Decrease theMinimum MS peak intensity in the m/z Tolerance group on the MS Parameters
tab. Refer to the section: MS Parameters Tab.

• (Oligonucleotide workflow) Increase the Intensity tolerance in the Isotope Pattern Tolerances
group on the MS Parameters tab.

Too Many Potential Metabolites Found
To reduce the number of potential metabolites found:

• Select a different peak finding strategy. Refer to the section: About Peak Finding Strategies.

• Increase the minimum chromatographic intensity on the Chromatographic Data tab. Refer to
the section: Chromatographic Data Tab.

• Reduce the retention time window on the Chromatographic Data tab. Refer to the section:
Chromatographic Data Tab.

• Reduce themass range window on theMS Parameters tab. Refer to the section: MS Parameters
Tab.

• Increase theMinimum MS peak intensity in the Isotope Pattern Tolerances group on the MS
Parameters tab. Refer to the section: MS Parameters Tab.

Long Processing Times
Processing time is affected by many factors, including data complexity, processing parameters,
workstation, and operating system.

To reduce the time needed for processing:

1. Close any other applications that are running on the workstation.
2. Change the processing parameter values. For example:

• Reduce the number of algorithms selected.

• Increase the minimum chromatographic intensity on the Chromatographic Data tab.

• Reduce the retention time window on the Chromatographic Data tab.

• Increase the minimum MS peak intensity on the MS Parameters tab.
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• Reduce the mass range window on the MS Parameters tab.

• Reduce the number of mass defect filters selected (for small molecules only).

• Reduce the number of biotransformations.

• (Peptide, oligonucleotide, and ADC workflows) Reduce the number of catabolites
generated by adjusting the compound-specific parameters.

Show the ProgramData Folder
The Microsoft Windows operating system might hide the C:\ProgramData folder. After installing
the Molecule Profiler software, make sure that all users can view the
C:\ProgramData\SCIEX\Molecule Profiler Data folder. If the folder is not visible, then complete the
following procedure:

1. In File Explorer, click View > Options.
The Folder Options dialog opens.

2. Select the View tab.

3. Click Hidden files and folder > Show hidden files, folders, or drives.
4. Click Apply.
5. Click OK.

Known Issues and Limitations
Results Data

• When determining the MS peak area, a time conversion factor of 60 is now being applied to
the calculations.

Interpretation

• When preparing for structural assignment, always click Find after making changes to the
Interpret Data dialog. The software recalculates the list of available formulas based on the
selected settings.

Correlation

• When the relative response factor (RRF) of a specific metabolite is changed, the MS area is
multiplied by the RRF value. The updated MS area of the selected metabolite is shown in the
Correlation details pane, in each of the Linear graphs, Bar graphs, and Tables.
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Reporting

• If conflicts with the Microsoft Word report templates occur when reports are created, then make
sure that all of the Microsoft Office applications are closed and try again.
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A thio-phosphoramidate oligonucleotide conjugated with a benzyl pentane linker tethered to the
5′-thio-phosphate end.

Chemical Structure, Formula, and Monoisotopic MassSequence

Figure A-1 C149H203N65O57P 14S14 ( 4695.7400)
5′-ATCGATCGTTTAAA-3′

Create the Other Terminus
Follow the general scheme for identifying the substructures that make up the 5' linker moiety.
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Figure A-2 Other Terminus

1. Click Edit > Custom Elements.
2. On the Oligo List tab, click New.

The New Oligo Residue or Terminus dialog opens.

3. In the Name field, type a name, for example 5' benzyl-pentane terminus.
4. In the Symbol field, type a symbol, for example /CustomBP/.
5. In the Composition Type field, select Other Terminus.
6. Complete the fields for the other terminus.

Table A-1 Other Terminus Fields

ValueField

C11H15Terminus Moiety

OTerminus Linker

HOPSPhosphate Core

7. Click OK.
A Warning dialog is shown, with the message, The "Terminus Moiety" field is usually odd
electron. Do you want to continue?
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8. Click OK.

Create the Internal Residues as Other Residues
Follow the general scheme for identifying the substructures that make up the custom bases.

Figure A-3 Other Residue

1. Click Edit > Custom Elements.
2. On the Oligo List tab, click New.

Tip! When creating custom residues, define all four nucleotides. It is recommended to
create a single nucleotide, and then click New From to create the three remaining
nucleotides.

The New Oligo Residue or Terminus dialog opens.

3. For the Adenine nucleotide, follow these steps:

a. In the Name field, type Custom dA.
b. In the Symbol field, type /CustomdA/.
c. In the Composition Type field, select Other Residue.
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d. Complete the fields for the other residue.

Table A-2 Other Residue Fields

ValueField

C5H4N5Base

O5' Linker

C5H70Sugar Core

NH3' Linker

HPOSPhosphate Core

e. Click OK.
A Warning dialog is shown, with the message, The "Sugar Core" field is usually odd
electron. Do you want to continue?

f. Click OK.
4. For each of the remaining three nucleotides, do this:

a. Select /CustomdA/ and then click New From.

The New Oligo Residue or Terminus dialog opens.

b. Type the Name, Symbol, and Base. For base formulas, refer to the following table.

Table A-3 Base Formulas

BaseSymbolNameNucleotide

C5H5N2O2/CustomdT/Custom dTThymine

C5H4N5O/CustomdG/Custom dGGuanine

C4H4N3O/CustomdC/Custom dCCytosine

c. Click OK.

Write a Custom Sequence
1. Click New > Oligonucleotide.
2. In the Sequence pane, type:
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/CustomBP/ /CustomdA//CustomdT//CustomdC/ /CustomdG//CustomdA//CustomdT/
/CustomdC//CustomdG//CustomdT/ /CustomdT//CustomdT//CustomdA/
/CustomdA//CustomdA/

3. Click in the Chemical formula field.
C149H203N65O57P14S14 is shown in the field.
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How metabolites are named by the software
Names are assigned to potential metabolites in two ways. If the peak is a predicted metabolite,
then the name is based on the matching biotransformation, cleavage metabolite, or a combination
of the two. If the peak is an unexpected metabolite, then it is named Loss of or Gain of.

The software also assigns a potential formula to each metabolite. Users can change the formula
by either selecting a different formula from a list of formulas suggested by the software or by typing
a formula manually.

IDA
An IDA method finds ions in full scan spectra during acquisition and then decides in real-time
which ions to analyze by MS/MS.

peak IDs
The software labels potential metabolites using M1, M2, M3, and so on, based on retention time
and m/z value.

relative response factor
The relative response factor (RRF) is a value by which the peak area is multiplied, to artificially
increase or decrease the peak area. It can change the plotting of that peak area in the correlation
details graph.

reference spectrum
The MS/MS spectrum of a specific compound that is used when identifying potential metabolites.
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Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical issues
that might arise. For more information, visit the SCIEX website at sciex.com or contact us in one
of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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The latest versions of the documentation are available on the SCIEX website, at
sciex.com/customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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